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1.0 Introduction  
This manual of operations (MOP) outlines the procedures to be followed for the Patient-
Centered Hearing Aid Trial (P-CHAT). P-CHAT is the execution of the contract titled, 
“Comparison of Direct to Consumer Delivery Models for Hearing Devices” sponsored by 
the Patient Centered Outcomes Research Institute (PCORI) under contract number HL-
2019C1-16094. The project is hosted at Northwestern University by Principal 
Investigators Sumit Dhar and Larry Humes. The project was operational on June 1, 
2020 and will be executed at four clinical sites. 

2.0 Overview 
Hearing aids are the most common and appropriate treatment for most adults with 
hearing loss. Approximately 40% of those over the age of 60 years are affected by 
hearing loss. Only 20% of these individuals purchase and use hearing aids. The Over-
the-Counter Hearing Aid Act of 2017 is designed to decrease cost and make it easier for 
consumers to purchase and use hearing aids. The best methods for distributing hearing 
aids without the involvement of a professional are not known. 
 
The overall goal of this proposal is to compare two over-the-counter (OTC) models of 
hearing aid distribution and fitting against audiology-based best practice (AB. This goal 
will be achieved through the following specific aim: 

To determine whether brief consumer decides (CD) and Efficient Fit (EF) models 
for hearing aid provision are non-inferior to current audiology-based best 
practices (AB). 
 

Outcomes of hearing aid use when the hearing aid is fit using one of three possible 
methods (AB, CD, and EF) will be measured after 6 weeks and 6 months of hearing aid 
use. The basic questions being asked are whether outcomes are similar for the three 
methods of fitting hearing aids. 
 
The results of the study would help inform professionals, policy makers, as well as 
patients about whether alternate methods of distributing and fitting hearing aids can 
lead to outcomes similar to those achieved with a licensed healthcare provider. 

3.0 Study Protocol 
P-CHAT is a three-arm blinded multi-site randomized controlled trial. Individuals (N = 
591) between 50 and 79 years old with self-perceived mild or moderate hearing difficulty 
who have not tried hearing aids previously will be recruited at four clinical study sites. 
Participants blocked by degree of hearing loss at each site will be randomly assigned in 
to the Audiology-Based best practice (AB), brief Consumer Decides (CD), and Efficient 
Fitting (EF) arms. Benefit and satisfaction as well as other outcomes will be measured 
at 6 weeks and 6 months after hearing aid fitting. The full protocol is included as an 
appendix. 
 
* The CD group is referred to as the CD group for brevity in the rest of the document. 



Version 3.2  -  October 4, 2022   Page 7 of 124 
 

4.0 Study Organization and Responsibilities 
The study is hosted at Northwestern University in the Auditory Research Laboratory. 
The PIs, Sumit Dhar and Larry Humes are responsible for all aspects of the study. Mary 
E. Meskan oversees the day-to-day execution of the project with assistance from Anna 
Pitman and Madeline Pitman. Anna Pitman (Research Study Coordinator) serves as the 
primary liaison with the members of the stakeholder advisory group, oversees 
recruitment, as well as monitoring enrollment numbers and device sales.  Madeline 
Pitman (Research Assistant) is responsible for contacting and scheduling participants.  
This position was filled by Gabriel Lima from August 2020 to May 2021 and by Kayla 
Gray from July 2021 to May 2022. 
 
The four clinical sites are led by Tracy Winn (Northwestern University), Mali Patel 
(Northwestern Medicine), Tom Wardzala (Sertoma Speech and Hearing Centers), and 
Leslie Rolph (University of Texas Medical Branch).  

4.1 Roster 

4.1.1 Coordinating Center 

2240 Campus Drive  
Evanston, IL 60208 
877-884-5242 
  p-chat@northwestern.edu 
 
 

Larry Humes, Co-Principal Investigator, larry.humes@northwestern.edu 
 
Sumit Dhar, Co-Principal Investigator, s-dhar@northwestern.edu 

 
Mary Meskan, Project Manager, mary.meskan@northwestern.edu 
 
Anna Pitman, Research Study Coordinator, anna.pitman@northwestern.edu 
 
Madeline Pitman, Research Assistant, madeline.pitman@northwestern.edu 
 
Chun Chan, Engineer, c-chan5@northwestern.edu 

 
Julia Lee, Co-Investigator & Biostatistician, jungwha-lee@northwestern.edu 
 
Jasleen Singh, Postdoctoral Fellow, jasleen.singh@northwestern.edu 

 
 
  

mailto:p-chat@northwestern.edu
mailto:larry.humes@northwestern.edu
mailto:s-dhar@northwestern.edu
mailto:mary.meskan@northwestern.edu
mailto:anna.pitman@northwestern.edu
mailto:madeline.pitman@northwestern.edu
mailto:jungwha-lee@northwestern.edu
mailto:jasleen.singh@northwestern.edu


Version 3.2  -  October 4, 2022   Page 8 of 124 
 

4.1.2 Clinical Test Site Leads 

Tracy Winn, AuD 
Northwestern University Center for  
   Audiology, Speech, Language, and 
Learning (NUCASLL) 
2315 Campus Drive 
Evanston, IL 60208 
(847) 491-3165 
 
Malini Patel, AuD 
Northwestern Medicine 
Department of Otolaryngology 
675 N. Saint Clair St. 
Fifteenth Floor, Suite 200 
Chicago, IL 60611 
(312) 695-8182 
 
Tom Wardzala, AuD 
Sertoma Speech and Hearing Center 
10409 S Roberts Rd 
Palos Hills, IL 60465 
(708) 599-9500 
 
Leslie Rolph, AuD 
Center for Audiology and Speech 
Pathology 
University of Texas Medical Branch 
700 University Blvd. 
Galveston, Texas 77555-0523 
(281)  338-0829
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4.1.3 All Site Personnel 
Site AudU (Unblinded) AudB (Blinded) 
 NU Evanston Tracy Winn Catherine Fabian 
  Elizabeth Meyer  Katherine Swem 
      
NU Med Malini Patel Lindsay Weberling 
  Denise Greiner Sara Claycomb 
    Allyson Weiss 
      
Sertoma Thomas Wardzala  Nahlah Floyd 
     
   
UTMB Leslie Rolph Kendra Huskey 
  Deb Carlson Elizabeth Surface 
    Kimberly Bose  
P-CHAT Lab  Sanjana Kumar Alexis Remshak 
   Katherine Coleman Pranali Suresh 
 Ethan Chen Jasleen Singh 
   
Others   
 Julia Lee Sumit Dhar 
 Mary Meskan Larry Humes 
 Anna Pitman  
 Madeline Pitman  
 Chun Chan  
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4.1.4 Data Safety Monitoring Board  

Chair: 
Megan York Roberts, PhD 
Associate Professor 
Roxelyn & Richard Pepper Department of 
  Communication Sciences and Disorders 
Northwestern University 
megan.y.roberts@northwestern.edu 

 
Ruth Bentler, PhD, University of Iowa 
Kwang-Youn Kim, PhD, Northwestern University 
Don Nielsen, PhD, Don Nielsen Consulting, [Executive Secretary, Patient Advocate] 
 

4.1.5 Stakeholder Advisory Group 
Stakeholder Group  Name  
Patient Mr. Earl Meyer  
 Ms. Jan Shiffman  
 Ms. Virginia Moore  
 Ms. Sarah Wegley  
 Ms. Marilyn Jewell  
 Mr. Larry Horwitz (deceased) 
Audiologist  Dr. Deborah Carlson  
 Dr. Kim Cavitt  
 Dr. Darrin Worthington   
Advocate  Ms. Elaine McCaffrey  
 Ms. Deirdre Keane  
 Dr. Sunil Metkar  
Industry  Dr. Laurel Christensen  
 Dr. Andy Sabin  
 Dr. Mead Killion 

 

4.1.6 Contacts for Questions 

Protocol Questions 
Mary Meskan mary.meskan@northwestern.edu, 

847-491-2470 Hearing Aid Qs 
Supplies 
Scheduling Madeline Pitman madeline.pitman@northwestern.edu 

877-884-5242 REDCap 
Adverse Event (AE) 

Anna Pitman anna.pitman@northwestern.edu 
877-884-5242 

Serious (AE) 
Stakeholder Group 
IRB Qs 

 

mailto:mary.meskan@northwestern.edu
mailto:madeline.pitman@northwestern.edu
mailto:anna.pitman@northwestern.edu
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4.2 Coordinating Center 
 
The responsibilities of the Coordinating Center include: 

• Development and maintenance of study materials including the MOP and study 
forms 

• Development of the randomization scheme and procedures 
• Development of the data flow and data management procedures including data 

entry, error identification and correction 
• Development and maintenance of central REDCap database and survey 

instruments for all data collection 
• Formation of the Stakeholder Advisory Group (SAG) 
• Scheduling and executing meetings of the SAG 
• Communication with the SAG 
• Addressing questions and concerns of the SAG 
• Formation of Data Safety Monitoring Board (DSMB) 
• Scheduling and executing meetings of the DSMB 
• Communication with the DSMB 
• Addressing questions and concerns of the DSMB 
• AE and SAE monitoring and reporting 
• Communications with study sites, scheduling of meetings and training sessions, 

responding to and documenting ad hoc communications 
• Site visits (virtual or physical) to ensure adherence to the protocol and 

procedures 
• Quality control procedures 
• Reports (e.g. enrollment, adverse events, participant status, site performance, 

quality control, DSMB) 
• Initiation and maintenance of single IRB through Northwestern University 
• Procuring and distributing all study supplies 
• Purchasing, checking, programming, and distributing all study hearing aids 
• Monitoring and replenishing hearing aid inventory at all study sites 
• Creating and maintaining payment mechanisms for hearing aids for all study 

sites 
• Creating and maintaining gift card disbursement mechanism for participants at all 

study sites 
• Advertising the study locally for all study sites 
• Recruiting and scheduling participants for all study sites 
• Sending appointment reminders to participants enrolled at all study sites 
• Creating and maintaining record on clinicaltrials.gov 
• Distribution of all changes, updates and policies of reports and documents to all 

participating study sites, NIA and to the DSMB as necessary 
• Reporting to PCORI staff monthly 

 



Version 3.2  -  October 4, 2022   Page 12 of 124 
 

4.3 Study Sites 
The roles and responsibilities of the investigators and study sites include: 

• Participation in protocol finalization and preparation of study materials 
• Compliance with protocol, MOP, IRB, Federal and state regulations 
• Membership in Research Team 
• Screening and enrollment of participants 
• Protection of participants' rights 
• Data collection and participant follow-up through study completion 
• Transfer of data to coordinating center and resolution of all queries  
• Compliance with and accountability of administration of study intervention 
• Retention of audiogram and MOCA physical records and subsequent transfer to 

coordinating center 
• Checking, programming, and service of hearing aids for participants involved in 

study as required and appropriate 
• Reporting equipment or process malfunction to the Coordinating Center in a 

timely fashion 
• Collaborating with the Coordinating Center in resolving equipment and process 

malfunction 
• Communication of questions, concerns, and/or observations to the Coordinating 

Center 
 

4.4 Research Team 
The Research Team comprises of the PIs, Project Manager, Research Project 
Coordinator, Research Assistant, and the leads from each study site. 
 
The following areas fall under the purview of the Research Team: 

• Design and conduct of the study 
• Review of the essential study documents, including the protocol, protocol 

amendments, MOP, and data collection forms 
• Review of data collection practices and procedures 
• Monitoring recruitment and retention of study participants 
• Changes in study procedures as appropriate 
• Review of study progress in achieving goals and taking necessary steps to 

ensuring the likelihood of achieving those goals 
• Review and implementation of recommendations from the DSMB 
• Review and implementation of recommendations from the IRB 
• Review and implementation of recommendations from the SAG  
• Review and response to other general advice and/or recommendations   

4.5 Stakeholder Advisory Group 
The stakeholder advisory group (SAG) is a 15-person committee comprising six patient 
representatives, three audiologists, three hearing device industry representatives, and 
three patient advocates. The SAG was formed prior to the submission of the proposal 
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and the group met in person once prior to the submission to shape the proposal. The 
SAG is scheduled to meet four times during the first year of the project and twice in 
each of the second and third years.  
 
The PIs and study personnel from the Coordinating Center will organize the SAG 
meetings, create and distribute the agenda, and be responsible for implementing the 
recommendations of the SAG. The SAG will receive an update at each meeting about 
study progress, next steps, and unexpected events. Input from the SAG will be sought 
in key areas such as recruitment, retention, and dissemination. 
 

4.6 PCORI’s Role and Responsibility   
PCORI is the funder of the study. The PIs and study personnel are responsible for 
providing PCORI with timely reports as described in the contract. A monthly meeting is 
scheduled between PCORI and the PIs to discuss any and all issues related to the 
study. 

5.0 Training Plan 
After development of the study protocol, participating personnel participated in an online 
training. Each step of the protocol from recruitment, scheduling, to exit mechanisms 
were discussed and demonstrated including use of the hearing aid selection application, 
REDCap for data entry, and electroacoustic procedures for checking and setting up 
hearing aids. Study personnel underwent separate certification for administration of the 
MoCA.  
 
Following the online training, study kits were distributed to each study site and a 
demonstration walk through was organized at each site. Sumit Dhar attended the walk- 
through sessions at Northwestern Medicine and Sertoma. Mary Meskan attended the 
walk through at Northwestern University. The walk through at University of Texas 
Medical Branch was conducted virtually and attended by Mary Meskan, Sumit Dhar, 
and Gabe Lima. Gabe Lima also provided virtual support during the walk throughs. 
 
Prior to initiation of data collection from enrolled participants, we will attempt to engage 
two pilot participants for each study site. Site personnel will conduct all three sessions of 
the study with the pilot participants. These sessions will be used as the final 
troubleshooting step. 

6.0 Communications Plan 
The personnel at the Coordinating Center and the PIs will use Microsoft Teams for 
regular communications. Members of the Research Team will also have access to this 
Teams account.  
 
The Research Team will meet weekly during a designated hour. The Project Manager 
will develop the agenda for these meetings. The meetings will be conducted over Zoom 
or similar platforms and will be recorded. Meeting notes will be maintained along with 
links to the recordings by the Research Assistant. 
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The Research Study Coordinator will be the main liaison for communication with the 
DSMB and SAG. The DSMB will meet at least twice each year during the project. The 
SAG will meet four times during the first year of the project and two times each during 
the second and third years. 
 
Email will be used for communication as needed. A directory with contact information of 
all study personnel will be available in the “Research Team” portion of the research 
website (p-chat.soc.northwestern.edu). 

7.0 Study Flow 
The study is accomplished over three visits. The first visit encompasses a screening 
section. Once the participant qualifies for the study, they are randomly assigned to one 
of the three arms and study measures commence. The second and third sessions are 
six weeks and six months after the first session, respectively. 
 
Figure 1: Study Flow Diagram 
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8.0 Recruitment and Retention 
Individuals between 50 and 79 years old with self-perceived mild or moderate hearing 
loss who have never tried using hearing aids will be recruited for participation. Self-
reported perceived hearing difficulties involving problems with speech communication in 
everyday situations will be assessed using the Hearing Handicap Inventory in the 
Elderly Screener [HHIE-S]. Participants will also be required to have normal cognitive 
ability as determined by a score equal to or greater than 23 on the Montreal Cognitive 
Assessment [MoCA]. Participants will be able to read and understand English and have 
symmetric hearing loss, no greater than moderate in degree. Finally, participants will 
agree to pay $650 privately for a pair of hearing aids. 
 
Participants will be recruited from four research locations: Evanston, Chicago, Palos 
Hills, IL; and Galveston, TX. Recruitment will be done through paid online advertisement 
(Google Ads, Facebook Ads, Nextdoor), free online platforms (Research Match, The 
New Normal, Facebook groups, NU Clinical Trial), flyers (community centers, senior 
living centers), and paid print advertisement in local newspapers. We expect to recruit 
an average of 28 participants/month for two years, spread across all four research sites. 
This equals to about 2 participants/week per site. 
Participants will receive an incentive of a $75 gift card upon finishing the third session. 
We will send email reminders two weeks, one week, and one day before their 
appointments, and also call participants one week and one day before their 
appointments. All participants will have access to the project office toll-free phone 
number for all questions. 
 
The above-mentioned recruitment and retention plans may have to be modified based 
on actual recruitment and attrition data. Recruitment and attrition data will be reviewed 
during weekly meetings of the Research Team. These data will also be discussed 
during each meeting with the Stakeholder Advisory Group. Strategies will be modified 
based on these discussions. 

8.1 Screening and Eligibility Criteria  

8.1.1 Prescreening 

Interested participants responding to the ads will be redirected to the study website (p-
chat.soc.northwestern.edu), to the email address p-chat@northwestern.edu, or to a toll-
free phone number (877-884-5242) located at the P-CHAT office in Evanston. The 
website provides participants with detailed information about the study and the link to 
the online screening (on Qualtrics). Participants who prefer calling the phone number 
will be given the same information about the study and will be asked the same 
screening questions as those participants screened online.  
 
Recruitment/Pre-Screening Phone Script. 

http://p-chat.soc.northwestern.edu/
http://p-chat.soc.northwestern.edu/
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8.1.2 Inquiries about Hearing Aid Make and Model 

It is possible that potential participants enquire about the make and model of hearing 
aids. In these cases, study staff will provide the potential participant the following 
information. 
 
We are glad you are interested in participating in the P-CHAT study. All participants will 
be fit with the same model of hearing aids. The hearing aids for this study are approved 
by the FDA, and they are manufactured by one of the six largest hearing aid companies 
in the world. During the first session, you will find out the make and model of the hearing 
aids. You have the option of withdrawing from the study at any time. 
 

8.2 Screening Log 
Pre-screening data are maintained in a secure Qualtrics database. Screening data from 
Session 1 are maintained in a secure REDCap database. Both databases can only be 
accessed through a VPN connection to Northwestern’s IT infrastructure. Logging into 
either system also requires a Northwestern University NetID and password. Access to 
specific “surveys” in the REDCap database are controlled through privilege control 
mechanisms. Data logs for both screening stages will be maintained for the duration of 
the study and nominally perpetually thereafter. 

8.3 Eligibility Criteria 
• Age 50-79 years 
• Self-reported perceived hearing difficulties involving problems with speech 

communication in everyday situations (assessed by Hearing Handicap Inventory 
in the Elderly Screener [HHIE-S] > 4) 

• No previous hearing aid use. The participant should not have owned and used 
hearing aids or even participated in a formal hearing aid trial. 

• Normal cognitive ability (assessed by Montreal Cognitive Assessment [MoCA] 
score ≥  23) 

• Ability and willingness to pay privately ($650.00) for hearing aids  
• Ability to read and understand English 
• Symmetric hearing loss, no greater than moderate in degree 

• Thresholds > 20dBHL in at least one frequency in each ear 
• 4FPTA at .5, 1, 2, 4 kHz < 50dB in at least one ear 
• Difference in thresholds between ears at 3 or more frequencies NOT > 20 dB 
• Difference in thresholds between ears at 500 or 1000 Hz NOT >/= 40 dB  

 

9.0 Informed Consent  
Informed consent is obtained by one of the site audiologists. The electronic consent 
forms are presented on a tablet computer to the participant. The site audiologist is 
available to answer questions and provide clarification. The participant will be offered 
paper or electronic copies of all forms. The participant signs five forms in two stages 



Version 3.2  -  October 4, 2022   Page 17 of 124 
 

during the first session. Descriptors for each form are included. In the first stage prior to 
the qualification process for the study, the participant will sign the following forms: 

• Screening Consent Form [This form describes the initial process to determine if 
you will qualify for the study.] 

• Permission to Contact Form [By signing this form you give us permission to 
contact you for other studies conducting by our research group. We will not share 
your contact with any other research group without your permission.] 

 
Following the screening process described in Section 8.1.2, provided the participant 
qualifies for the study, the following forms will be read and signed, as indicated: 

• Study Consent Form [This form describes the full study you will be participating 
in. By signing this form you are agreeing to participate in the study.] 

• Hearing Aid Agreement [This form tells you about the hearing aids you will be 
buying, the terms under which you can return them for credit, and the warranty.] 

 

10.0 Study Intervention 
The hearing aid used in this study is the ReSound LiNX Quattro 9, RE961, packaged as 
an open-fit behind-the-ear (BTE) receiver-in-the-ear (RIE) hearing aid. Some of the 
technical features of this device are as follows: (1) 12-channel Warp sound processing 
(10 gain handles for programming); (2) digital feedback suppression; (3) noise 
reduction; (4) programmable directional microphones; (5) low power consumption chip 
technology; and (6) rechargeable batteries. All subjects in all groups will be fit with this 
high-quality hearing aid in both ears. The device, representing one of the two most 
popular hearing aid styles, is available in 14 colors of which three will be used here 
(grey, beige, brown).  Medium power (MP) receivers will be used on all devices.   
 Representative ANSI S3.22-2014, 2-cm3 coupler specifications include high-frequency 
average reference-test gain (60 dB SPL input), full-on gain (50 dB SPL input), and 
maximum output (90 dB SPL input) of 36 dB, 50 dB, and 113 dB SPL, respectively. The 
hearing aids are rechargeable and each participant will receive a charger with the 
hearing aids. Each pair of hearing aids will also be supplied with a packet of wax 
guards, cleaning tools, and an assortment of dome sizes. All patients will pay $650 for 
the pair of devices and a charger, a price thought to be representative of soon-to-be-
approved OTC hearing aids. (The production costs of the devices: $400/pair.)  The cost 
includes a 4- year warranty for repair, loss, and damage.  Participants will pay a $100 
deductible if lost or damaged within the first 6 weeks, and $195 deductible after 6 
weeks. 

 

11.0 Randomization Method 
This section of the MOP describes the randomization approach and procedures, 
including: 

• Randomization Plan:  The random assignment of sequential enrollees in each 
hearing-loss severity category to each of the three groups will make use of a site-
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specific pre-generated randomized list produced from a random-numbers table. 
For example, for the targeted total sample of 353 subjects with mild-moderate 
ARHL, sequential subjects S1, S2, S3, S4, S5, S6, S7, S8…S353 might be 
assigned, based on a pre-generated randomization, to groups AB, AB, CD, EF, 
EF, CD, AB, CD…EF. 

• Process Responsibilities: The randomization table will be generated MPI 
Humes in consultation with biostatistician Dr. Lee. The randomization tables will 
be stored on REDCap.  

• Procedure for Randomizing a Participant:  The randomization process will be 
activated as a survey instrument after hearing test results have been supplied 
during the screening process. The unblinded site audiologist will activate this 
survey instrument, choose the participant ID, and execute the randomization 
process by clicking on a button on the survey instrument web page. The 
audiologist will then change the input to the “Complete?” field on the survey form 
to mark the process “Complete.” The randomization tables will be maintained 
during after the study and can be examined at any time.  
 

A video tutorial on the randomization process is available here. 
 

12.0 Blinding and Unblinding (Masking and Unmasking) 
The PIs Sumit Dhar and Larry Humes will remain blinded to treatment arm assignment 
till the final session with the last participant has been conducted. Each clinical site will 
have designated blinded and unblinded audiologists referred to as AudB and AudU, 
respectively. The site leads will serve in the AudU role. 
 
The AudU will perform all session activities following randomization in Session 1. The 
AudB will perform the PHAST-R in Sessions 2 and 3. Other study steps can be 
conducted by either AudU or AudB. The location of activities will be planned to ensure a 
participant’s presence in one room or location cannot definitively disclose their group 
assignment.  
 
All activities at the NM and SER sites will occur in the same room for all treatment 
groups. Participants enrolled at NU and UTMB and assigned to either CD or EF groups 
will provide responses to some questionnaires in the room where those assigned to the 
AB group will undergo hearing aid fitting. 
 

In cases of accidental or inadvertent unblinding, the AudB will immediately complete the 
Unblinding Reporting form in REDCap. The data fields included in this form are below: 

Date: ____/_____/________  
Audiologist Name: _________________  
Participant ID: _____  
Session #: _____  
Site: (   ) NU   (   ) NM  (   ) SER   (   ) UTMB  
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Please describe how unblinding occurred: ___________________  
_____________________________________________________  
_____________________________________________________  
_____________________________________________________  
 

13.0 Study Measurements and Procedures  
 

13.1 Help During Sessions 
In case of any difficulty with during set up or the session please call the coordinating 
center at 877-884-5242. 
 

13.2 Study Equipment 
 
Item Use Session 

iPad (3) 

Consent 1 
Questionnaire Response 1, 2, 3 
Randomization 1 
Fitting App 1 
Calibration As needed 

   
Hearing Aid Selection 
Boxes Hearing aid selection and fitting for CD and EF 1 

   

Clover Device 
Hearing aid payment 1 
Hearing aid return As needed 
Gift cards 1, 2, 3 

   
PHAST-R Box PHAST-R administration 2, 3 
   
Audiometer Audiogram 1, 3 
   
Verifit Hearing aid measurements 1, 2, 3 
   
Laptop with 
Noah+SmartFit Hearing aid programming 1, 2, 3 

   
Speaker+Mirror+Call 
Button Hearing aid selection and fitting for CD and EF 1 

 

13.3 Hearing Aid Selection/Fitting Setup 

13.3.1 iPad Orientation 

All three tablets supplied by the Coordinating Center are set up identically. The following 
figure details the use of each icon on the home screen. 
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13.3.2 Items Needed for Session 1 

• The following are needed for the AB group. 
o AB fitting kit 
o Hearing aid charger 
o Otoscope 
o Verifit system, couplers, probe tubes, and USB stick 

§ Calibration should be done weekly for the coupler reference 
microphone and before each session for the on-ear reference 
microphones 

o Computer running Noah and Resound Smart Fit software. 
§ Refer to Appendix G for information about using the dedicated 

laptop versus a PC and settings for Smart Fit Preferences   
 

• The following set up procedure is used for CD and EF groups. 
o Use the following figure to guide setting up fitting table. You will need 

the following items. 
§ Bose speaker 
§ Speaker block 
§ Mirror 
§ CD/EF fitting kit 
§ Call button 
§ Hand sanitizer and tissues 

o Computer running Noah and Resound Smart Fit software. 
§ Refer to Appendix G for information about using the dedicated 

laptop versus a PC and settings for Smart Fit Preferences  
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Sample Setup for CD/EF groups 

 
 

• Check that 2 iPads are charged. 
• Check that the Bose speaker is charged.  

• Use the silver Bose speaker as the primary speaker and the black 
speaker as the back-up 

• The iPads and speakers are interchangeable and both speakers are paired to 
work with either iPad, but use: 
• iPad #1 for REDCap and sound level meter, held in portrait mode.  
• iPad #2 for the Fitting App, including the calibration noise, held in 

landscape mode.  
• Set the volume of the iPad running the fitting app as follows: 

• Click the lower volume button till volume is zero. 
• Click the higher volume button nine times (or the appropriate number of 

times if your calibration levels are different) 
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• Set the box of 
hearing aids in the center 
of the table in front of 
where the participant will 
be sitting and set the 

mirror on the table to the left of the box.  The Call button will be set within 
reach of the participant. See figure below. 

• Turn on the hearing aids (by either pressing and holding the button for 5 long 
seconds or by putting them in and taking out of a charger).   

• Turn on the paired remote controls.   
• Mute each pair of aids using the mute button on the remotes (microphone 

button on top right).   
• Ensure aids and remotes are in correct sections.  

 

13.3.3 Speaker Calibration [Conduct weekly or as needed] 

• Turn on the iPads and speaker.   
• Adjust the volume control on the iPad. 

• Turn down iPad volume all the way. 
• Increase the volume 9 button presses.  

• Position the speaker on top of the speaker block so that it is 40 inches away from 
the back of the participant’s chair.   

• Use the measuring ribbon to determine this distance by attaching the 
ribbon to the side of the block with a tack, as shown in the 
figure below. 

• Open the Fitting App on the iPad that will be running the Fitting App  
• Open the NIOSH SLM app on the other iPad. 

• In the NIOSH app, select Instantaneous level, which should be 
displayed in dB(A) 

• In the Fitting App, start the calibration noise on the first screen.   
• Hold the other iPad, running the NIOSH app, flat with the microphone facing the 

speaker at where the patient’s head would be (refer to figure below). 

Volume control 
buttons and 
microphone location 
on iPads. 
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• The level of the calibration noise should equal 63-64 dB SPL.  If it is higher or 
lower, adjust the output level of the iPad using the volume buttons so that it is 
within the range of 62 to 65 dB SPL.  

 
  

iPad with SLM position for 
calibration. 
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13.4 Session 1  
• Participant reports to front desk in person or by phone following local COVID-19 

protocol. 
• Greet participant in the waiting area or at front door depending on local COVID-

19 protocol. 

13.4.1 Qualification Screening [AudU or AudB] 

• Activate the “REDCapSurveyPage” icon. 
Do not close this tab till the end of the session when the participant has signed 
the receipt for gift card. 

• Enter the following from the confirmation email: 
o Screening/Session 1 Code  
o Participant ID  

 
• Hand iPad to participant and instruct them to answer questions till they arrive at a 

screen that asks them to hand the iPad back to the audiologist. 
 

• Participant will confirm the following and touch “Next” to proceed. 
o Participant ID 
o Personal Information  

§ Full Name 
§ Date of Birth 
§ Phone number 
§ Email 
§ Mailing address 
§ Gender 
§ Race/Ethnicity 

• The participant will complete the following forms. 
o Screening Consent Form 

§ Countersign as “person obtaining consent” 
o Permission to Contact Form 

 
Countersign the Screening Consent form as the “person obtaining consent.” 
Copies of the consent forms will be automatically sent to the participant via email. 
Paper copies of the forms can also be printed if the participant requests them.  
 
• The participant will complete the HHIE to verify self-reported hearing loss 

o HHIE 
§ REDCap will calculate score. If HHIE score is <=4, participant 

will be disqualified. 
 

• Participant will hand iPad back to the audiologist. 
 
• Confirm Site/Personnel Information:  

o Test site 
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o Test date 
o Name of Unblinded Audiologist (AudU) 
o Name of Blinded Audiologist (AudB) If the AudU will be completing the 

MoCA and audiogram, enter that name as both the AudB and AudU. 
 

• Confirm Participant Eligibility:  
o Complete all screening steps, even if participant is disqualified in one 

or more steps. 
o Verify date of birth: Check ID (if less than 50 or greater than 79 years 

of age, will be disqualified) 
o Verify no previous hearing aid use: 

§ Have you ever used (or tried using) hearing aids? Y/N (If yes, 
will be disqualified) 

o Verify ability to speak and read English: 
§ How well do you speak, read and understand English?  

• Very well / Well / Not well (will be disqualified) / Not at all 
(will be disqualified) 

o Verify ability to pay for hearing aid devices 
§ If you are eligible for this study and decide to enroll, you will be 

provided with two high quality, rechargeable hearing aids. 
Would you be able to pay $650.00 to purchase these? Y/N (If 
no, will be disqualified) 

 
• MoCA test of cognition 

o Have a paper copy of the MoCA test ready 
o Complete the MoCA test with the participant using a black pen on the 

paper form 
o Calculate the score and enter the score in REDCap. 
o Upload image of MoCA test form to REDCap. 
o If MoCA score < 23, participant will be disqualified. 

 
• Otoscopy 

o Sanitize hands 
o Perform otoscopy on each ear, noting status of ear canals and enter 

findings in REDCap re: cerumen in each ear: 
§ Clear 
§ Non-occluding 
§ Occluding 

 
• Audiogram 

• Escort participant into test booth and give instructions for pure-tone 
testing.   

• Use insert earphones 
•  Obtain air conduction thresholds in each ear at the following frequencies, 

using masking as necessary 
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• Use a black pen to record the responses on the paper Audiogram form 
for the following test frequencies: 

§ 250 
§ 500 
§ 1000 
§ 2000 
§ 3000 
§ 4000 
§ 6000 
§ 8000 

o Enter pure tone test results in REDCap.   
§ The thresholds for the first ear will be copied and displayed for 

the second ear.  Modify these thresholds to reflect those 
measured. 

o Scan paper audiogram into REDCap.  Put paper audiogram into 
secure file. 

o REDCap will calculate PTA for each ear and will display Degree of 
Hearing Loss based on PTA averaged for both ears. 

o Select the degree of hearing loss displayed by REDCap (if participant 
has been pre-assigned to an a study group, the degree will already be 
selected as “normal” and cannot be changed. 

13.4.2 Disqualification Process 

o REDCap will determine eligibility based on audiometric results: 
§ If Thresholds at all frequencies are < 20dBHL for both ears, 

participant will be disqualified. 
§ If 4FPTA at .5, 1, 2, 4 kHz are > 50dB in the better ear, 

participant will be disqualified. 
§ If difference between ears at 3 or more frequencies is > 20dB, 

participant will be disqualified. 
§ If difference between ears at 500 or 1000 Hz is >/= 40 dB, 

participant will be disqualified 
 
Eligible participants go to Continued Session 1 . 
 
REDCap will display a Disqualification message at the completion of the Screening if 
participant is disqualified for any of the eligibility requirements described above or in the 
previous section.  Use the following script to inform participant and to explain the next 
steps.  

13.4.3 Script to Inform Disqualified Participants 

“We have now completed the preliminary tests that help determine who can be included 
in this study. Unfortunately, your test results show that you cannot be included in the 
study at this time. This may be for a variety of reasons such as your measured hearing 
loss is either too little or too much, or the hearing loss in your two ears are not exactly 

https://nuwildcat.sharepoint.com/:w:/r/teams/gl_SOC_DharPICORI/_layouts/15/Doc.aspx?sourcedoc=%7B21FB9C02-847B-4583-A1CD-5D00A0A98130%7D&file=Audiogram.docx&action=default&mobileredirect=true&cid=e8004bee-f64e-4d1c-8b5a-f992b9f64e29
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the same, or you did not meet another qualification criterion. We are sorry. We will hold 
your name and contact you in case the inclusion criteria are changed in the near future. 
You are welcome to pursue hearing aids or any other treatment for your hearing loss 
here or at any other clinic of your choosing.  Please remember though that you will not 
be able to participate in this study if you try hearing aids.  
 
If applicable:  In your particular case we detected a big enough difference in hearing 
between your ears that we would recommend a full audiological evaluation or a visit 
with an ear doctor.” 
 
• Disqualified participants will receive $45 gift card ($25 for participation and $20 

travel reimbursement). 
• REDCap Survey will close.  Click on REDCap Login icon on iPad and follow 

instructions to access Gift Card Receipt 

• Have participant sign gift card receipt (they will be given the gift card during the 
Payment process) 

• Participants will be asked if they are a Northwestern Employee. 

• If participant selects “yes” a new set of fields will become available and 
should be completed. 

• If the participant is a temporary employee, print the linked DCFS form 
and obtain the participant’s signature. 

§ Upload a photo of the DCFS form on REDCap 
• Complete Exit Form in REDCap  

• Continue to Payment for Session 1 

13.4.4 Continued Session 1 [AudU or AudB] 

• Session 1 continues on REDCap for participants who qualify. 

• Confirm the following: 
o Participant ID 
o Participant Name 
o Test site 
o Test date 

• Hand iPad to participant to complete  
o Study Consent Form 

§ Countersign as “person obtaining consent” 
o Hearing Aid Agreement  

Copies of the consent form and hearing aid agreement will be automatically sent 
to the participant via email. Paper copies of the forms can also be printed if the 
participant requests them.  
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• If the participant decides NOT to continue in the study after reading the 
Consent Form and Hearing Aid Agreement: 

o Complete Exit Form and 1-Gift Card Receipt in REDCap  
o Continue to Payment for Session 1 

 

13.4.5 Randomizing Participants [AudU] 

• This step can only be completed by the Unblinded Audiologist (AudU). 

• Connect to NU VPN using the “GlobalProtect” icon on the iPad homescreen if 
you are not at NU. 

• Select the “REDCap Login” icon on the iPad homescreen. 
• Log into REDCap using your NetID and password. 
• Click on “Add/Edit Records” 
• “Choose an existing Record ID” using the drop-down menu 
• The directions for randomization are displayed on the original REDCap screen on 

the other browser tab where the data entry process has halted. 

• Select “1-Randomization” 
• Click the circular button in the branch assignment column for the record ID for 

your participant. 

• This will take you to a form where you will confirm “Test Site” in the “Group 
Randomization” division halfway down on the screen. 

• Click on the “Randomize” button. 

• Confirm “Test Site” and “Degree of Hearing Loss” on the pop-up window. 

• Click on the “Randomize” button. 

• A pop-up screen will display the group assignment. 

• Click on the “Close” button to close pop up window.  
• Change the “Complete?” drop down field to “Complete.” 

• Click the “Save and Exit Form” button. 

• Close this tab by clicking on the small “x” in the tab label. 

• Return to the other open tab and reload the page by clicking on the “reload” 
button in the address bar.  
Continue to Post Randomization 
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13.4.6 Session 1 – Post Randomization [AudU] 
• The participant will complete various questionnaires on their own. Give them 

the following information. 
 

“As you were told, this study is looking at different ways of selecting and fitting 
hearing aids. The next step is the selection and fitting of your hearing aids. For the 
purposes of the research project, it is important that you do not discuss details of 
how your hearing aids were chosen with others, including study staff. 

The study will be following specific steps, so unfortunately, we may not be able to 
answer your questions or discuss certain information.  Please feel free to use your 
phone or read something while I am completing some of the study steps which 
require my attention. 

 
• Accompany participant to a different room if necessary.  

• Hand the iPad (with REDCap open) and the Call button to the participant. 

• Instruct them to press the Call button once they arrive at a screen instructing 
them to hand the iPad back to the audiologist. 

• These questionnaires will be completed by the participant at this stage: 
o PHAP 
o PROMIS 
o Case History 

• If in AB group, continue to AB Group:  Hearing Aid Fitting Protocol 
• If in CD or EF group, continue to CD and EF Groups:  Hearing Aid Fitting 

Protocol  
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13.4.7 AB Group:  Hearing Aid Fitting Protocol [AudU] 

• This protocol to be completed only by the unblinded audiologist (AudU). 
• Have in the fitting room the following supplies: 

• AB Kit containing dummy hearing aids in 3 colors (Beige, Gray, and Brown), a 
measuring tool, domes of various sizes, extra receiver wires (R1, L1, R2, L2), 
and a tool for changing wires.  

• Otoscope and specula 
• Hearing aid charger 
• Probe tubes 
• Hand sanitizer 
• Alcohol wipes 

• If participant decides to exit during the AB fitting process, complete “1 - HA selection 
form” in REDCap before following the exit protocol. 

 

13.4.7a Choosing Hearing Aid Color/Parts 

• Sanitize hands 

• Show the participant the 3 colors of hearing aids using the dummy aids  

• may assist in the selection of color 

• may suggest that some hearing aid users match to their hair or skin color  
• Use otoscope to visually inspect pinnae and ear canals to gauge sizes  

• Use the measuring tool to select the receiver wire length: 1 (small) or 2 (medium):  

• Place the tool over the ear with the red or blue side of the tool facing out for the 
respective ear.    

• Pick the size that aligns closest to the top of the ear canal.  
• If the sizes of the right and left ears are different, pick one size for 

both.  Selecting the longer of the two for both is recommended to avoid the 
length being too small and pulling the dome out of the ear. 

 
In REDCap, answer questions about whether you were able to select the best wire 
length and dome size. Provide your suggested alternates if the ideal choices were 
not selected. 
 
The HFPTA will be calculated and the respective row in programming matrix will be 
displayed for use in setting programs 2 to 4 as VC settings at end of fitting. 
 

• A box number is generated corresponding to the selected color and wire length that 
will be taken from inventory.  Boxes numbered 1 to 6 are for the AB Group. 

• Take a photo of the box label using the iPad and upload to REDCap 
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• Put domes on hearing aids using domes in AB Kit.  Check that domes match the 
receiver type on the aids:  black domes for original MP 2B receivers and gray domes 
for new MP 2C receivers. 

• Put aids on participant and check fit of wires and domes 

• Ask participant if the domes feel too loose or tight.  

• If dome is too large or small, select another size from the AB kit.  
• If the receiver wire is too long or short, the other size is selected from the AB Kit and 

the receiver wires are replaced on the aids using the tool in the kit.   

• The receiver wires that were first tried will be set aside to be sanitized before 
being packaged and returned to the fitting kit.    

• NOTE:  the wire lengths and dome sizes should be the same for right and left ears 
for consistency with options in the CD and EF groups. 
•  It is possible that the participant will arrive with different-sized or mismatched 

domes in subsequent sessions because they will be provided with a set of 
varying-size domes. 
 

13.4.7b Hearing Aid Programming/Setup  

• Open Noah software 
• If Error message is displayed, cancel and restart Noah 

• If Error message continues to display after repeated restarts, refer to Appendix I 

• Open “New Patient” 
Enter:  Last Name = participant ID, First Name = AB  

Do NOT enter any other information.   

• Select OK 

• Select Audiogram module 

• Enter participant’s AC thresholds at 250 to 8k Hz for each ear using audiogram 
previously obtained.  

• Save. Confirm date and “OK” 

• Select ReSound SmartFit fitting module.   

• Power on hearing aids by removing from charger or pressing buttons for 5 
seconds.  Confirm aids are powering on by listening for 10 dings.  

• “Connect” hearing aids.   

• Once discovered, check boxes for left and right and verify by using “beep”; switch 
left and right if needed.   
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• “Continue” 

• Message:  “Audiogram Mismatch”;  Select “Use Session today’s date 
Audiogram”.   

• Message:  “Data Mismatch”;  Select “Reset to Initial Fit” in order to match to 
targets for participant’s audiogram.   

“Continue”  
• If message appears that aids need a firmware update to v.45, proceed with 

update. 
“Continue” 

• If message appears that SOFTWARE needs to be updated, you will need to use 
the PC, not the laptop, to connect to the hearing aids, which have version 1.18 
firmware.  Refer to Appendix G for further information.   

• Verify these settings: 

• NAL-NL2 

• Experienced non-linear user 
• Gain level = 100% 

• Select View (be sure to change this every time): 

• Stimulus Type = Speech weighted noise 

• Select Fitting: 

• Binaural Correction = on (red X = on) 

• Use bone conduction = off 

• Enable Safe Fitting = off  
• Select “Fit Patient” 

• This will take you to Gain adjustments screen.   

• Each of the four programs are identical and are called “All Around”.  They will be 
changed after the REM’s. 

• Verify Advanced Features: 
• Binaural Directionality III with Spatial Sense 

• Directional Mix = Very Low 

• Time Constants = Syllabic 

• DFS Ultra II 

• Put aids in ears and perform DFS calibration in each ear 

• Set to Moderate in each Program 1, 2, 3 and 4 
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• Noise Tracker II =per Environment 

• Wind Guard = Off 

• Impulse Noise Reduction = Mild 

• Expansion = Mild 
• Sound Shaper = Off  

• Verify Device Controls/ Manual Controls 

• Button Options: 

• Change Program = short button press 

• None = long button press (this will need to be reset to “None”) 

• Return to Gain Adjustments screen 

• Mute aids using speaker icons top left of audiogram target graphs 
 

13.4.7c Real Ear Verification 

• Clear data in Verifit by selecting Session and choosing Erase All Data.  This step 
can be skipped if Verifit was off and just turned on. 

• In Verifit:  Tests selection menu->On ear measures->SpeechMap  

• Select: 

• Dual view 

• On-ear or RITE 
• Open 

• Select “Audiometry” and select: 

• NAL-NL2 

• Adult 

• Transducer = Insert + foam 

• UCL Average 

• RECD Average 

• REDD (in Verifit 2) Average 
• Binaural = No (note:  this is the opposite of what you would 

assume, but we are using NO BINAURAL here due to differences 
in Smart Fit and Verifit’s target generation.) 

•  Language Non tonal 
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• Select “Continue” and enter AC thresholds for both ears using the audiogram 
previously obtained. 

• Calibrate:  Tests selection menu->On ear measures->Calibration 

• Attach probe tubes and hold microphone 2-3 ft from speaker.  Calibrate 
right and left microphones.  

• Sanitize hands  
• On-ear measures:  Place probe tubes in participant’s ears using best practices 

method, including Probe Guide function if available  

• Put aids in ears; unmute hearing aid being tested.  If using Verifit 2, and if 
hearing loss is symmetric, both ears may be tested simultaneously. 

• Select Test  
1. Test 1 = 65 dB SPL ISTS stimulus 

In Smart Fit, make adjustments to hearing aid gain in order to match to targets within ±4 
dB @ 1500 Hz and below and within ±7 dB @  2000 Hz and above).   

• Set Handles to 10.  Highlight gain for all three curves (50/65/80) at 
desired frequencies and adjust them together so that CR does not 
change.  

• Note: If aids are linked, changes will be made to both aids even 
though measuring in one ear.  Unlink if you do not want this to 
occur.   

• After adjusting, re-measure Test 1 using 65 dB SPL.   
2. Test 2 = 55 dB SPL ISTS Stimulus 
3. Test 3 = 75 dB SPL ISTS stimulus 

• MPO/LDL measurement: use instructions and categories on printed sheet. Link 
to MPO_LDL document  

 
Instructions:  
“The purpose of this test is to set your hearing aids so that sounds do not get what you 
feel is ‘Uncomfortably Loud’.  Here are categories of sound that describe loudness, from 
‘Very Soft’ up to ‘Uncomfortably Loud’.  We know that sometimes sounds are ‘Loud but 
OK’ but we do not want them to be ‘Uncomfortably Loud.’ I am going to play out a sound 
that will be changing in pitch.  Raise your hand or tell me to stop the sound if you feel 
that it is “Uncomfortably Loud”.  If it is “Loud, but OK”, then do not tell me to stop.” 

Categories of Loudness: 
• Uncomfortably loud 
• Loud, but okay 
• Comfortable, but slightly loud  
• Comfortable 

https://nuwildcat.sharepoint.com/:w:/r/teams/gl_SOC_DharPICORI/_layouts/15/Doc.aspx?sourcedoc=%7BE34599C9-D93B-45D4-9575-D0D2EE8A7079%7D&file=MPO_LDL-Procedure.docx&action=default&mobileredirect=true
https://nuwildcat.sharepoint.com/:w:/r/teams/gl_SOC_DharPICORI/_layouts/15/Doc.aspx?sourcedoc=%7BE34599C9-D93B-45D4-9575-D0D2EE8A7079%7D&file=MPO_LDL-Procedure.docx&action=default&mobileredirect=true
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• Comfortable, but slightly soft  
• Soft 
• Very soft 

 
• Select Test 4 for MPO  

• Test 4 = 85 dB SPL input (set max TM level as appropriate) 

• Make adjustments to MPO settings in Smart Fit and retest until output 
does not exceed LDL. 

• Adjust output in a particular frequency range, not across all 
frequencies 

• Reduce output first by 4 dB, then in smaller steps as needed (2 dB, 
then 1 dB) 

• Repeat all measures in opposite ear if testing ears individually 

• Re-link aids if unlinked 

• “Save” in Smart Fit 
• “Continue Fitting” 

13.4.7d Complete Hearing Aid Programming 

• Auto-relate:  Under Fitting>Autorelate>Apply gain changes from Program 1: All 
Around to the following programs: Program 2, 3, and 4.  Include Gain settings, 
MPO settings 
 

Setting Programs 2 to 4:  set programs P2, P3, P4 relative to P1 to be used as a volume 
control, so that 
P1 = Matched to targets 
P2 = VC softer 
P3 = VC softest 
P4 = VC louder 

 
1. REDCap will calculate and display the HFPTA using thresholds at 1, 2, 

and 4k Hz, and average this for the two ears  
2. The row corresponding to the HFPTA in this matrix will be displayed on 

REDCap.  These values will be used to adjust overall gain in each 
program, where the values are in dB. 

 
 

HFPTA at 1, 2, 4k Hz in dB HL P1 P2 P3 P4 
</= 21 0 -2 -4 +2 
22-29 0 -3 -6 +3 
30-38 0 -4 -8 +4 
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39-47 0 -5 -10 +5 
48-55 0 -6 -12 +6 
56-64 0 -7 -14 +7 
>/= 65 0 -8 -16 +8 

 
3. To adjust overall gain in a program: 

a. In Smart Fit’s table of gains, select “All” 
b. in middle section, select 1, 2, or 3 (dB) depending on the step size 

needed for adjusting gain.  Click on up or down arrow to adjust 
gain up or down. 

c. Check gains are correct relative to Program 1   
d. Repeat this for Programs 2, 3, and 4 .   

• Reset Data Logging 

• Go to black menu bar: Fitting>Tools>Data Logging 

• Select “Reset”, then select “continue/Start” 

• Go back to Fitting 

• Select “Save”.  Message:  Saved to Database. Saved to Instrument. 

• Save Clinician Report 
• Select “Summary>Clinician Report” 

• Select “Print” and when printer selection menu appears, select “print to 
pdf” and select location on desktop 

§ name file according to convention: 

§ S_<branch>_p<participant-id>_s<session number>_cr<clinician report> 

§ Example:  S_AB_p7_s1_cr.pdf 

 
• Select “Exit Smart Fit” 

• Remove hearing aids from ears. 

• Reboot hearing aids by putting in and taking out of charger. 
 

13.4.7e Test box coupler measures  

• Go back to Verifit to make 2cc coupler measures of programmed hearing aids. 

• Tests selection menu->Test Box measures->SpeechMap 

• Instrument = RITE 

• Put hearing aid(s) in coupler  
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• Verifit 1:  2 cc coupler sealed with putty 

• Verifit 2:  .4cc coupler with both aids coupled 

• Test with aids set to Program 1: 
Select Test 1:  Speech ISTS /Avg (65)   

• Select Test 2:  Speech ISTS/ Soft (55)  

• Select Test 3:  Speech ISTS/ Loud (75) 

• Select Test 4:  MPO 90 
 

• Press “Session” button.  Select “Store Session to File.” 

• Enter name of file by clicking on box next to “View & Search” and then typing on 
keyboard and using this naming convention: 

• V_<branch>_p<participant-id>_s<session number> 

• Example:  V_AB_p7_s1.xml 

• Save the Session data to the USB drive.   
 

13.4.7f Patient counseling 

• Sanitize hands 
• Counsel participant on use and care of hearing aids and charger using printed 

copy of Orientation Checklist   
• Include instructions to use aids at least 4 hours per day and to keep aids in 

charger when not being used. 
Show participant ReSound User Manuals (2), charger, tools, and extra domes that are 
in hearing aid box 
Have participant demonstrate skills listed on checklist 
Counsel regarding effective communication strategies using checklist 
Have participant wear hearing aids as they leave office 
Put hearing aid box in black ReSound bag 

 
Complete the following checklist on REDCap. 
• Speech Mapping completed on ear. 

• Gain and MPO targets achieved.   

• Speech Mapping completed in coupler. 

• Gains in Programs 2 to 4 adjusted according to matrix for HFPTA. 

https://nuwildcat.sharepoint.com/:b:/t/gl_SOC_DharPICORI/EX57NGe-Af9OgIVkmB2UQfkBKVIS-c8Tfuiuge_FC4gSjA?e=A8mAOw
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• HA Orientation checklist completed. 
 

Have participant sign the receipt for the gift card on REDCap  
Participants will be asked if they are a Northwestern Employee. 
If participant selects “yes” a new set of fields will become available and should be 
completed. 
If the participant is a temporary employee, print the linked DCFS form and obtain the 
participant’s signature. 
Upload a photo of the DCFS form on REDCap 
Close tab for REDCap on iPad. 
Continue to Payment for Session 1. 
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13.4.8 CD and EF Groups:  Hearing Aid Fitting Protocol [AudU] 

 

 
To be conducted by AudU only 
• Have CD or EF Hearing Aid Box ready with following items -- 6 pairs of charged 

hearing aids with charged remote controls paired to each set.   
o Turn on hearing aids and remotes 
o Mute all hearing aids using remotes 
o Check hearing aids are in compartments labeled with symbols that 

correspond to the labels on the aids and remotes. 
o 3 dummy hearing aids in 3 colors:  beige, grey, brown should be in the 

bottom “rainbow” sections 

• If participant decides to exit during the self-fitting process, complete “1 - HA 
selection form” in REDCap before following the exit protocol. 

• Start the Fitting App on iPad. The page should say “Welcome, [your name].” If it 
doesn’t, close the fitting app and log in again. Enter the following information: 

o Participant ID 
o Site name 

• Set-up iPad 

https://dharweb3.soc.northwestern.edu/webapps/pchat/#/
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o Use iPad in landscape mode standing on table, as shown in photo. 
o Ensure the volume on the iPad is set correctly (lower all the way and then 

raise volume by 9 clicks or the calibrated number of clicks). 
o Ensure that this iPad is paired with the speaker. Verify by playing the 

calibration noise. 
• Have participant seated at table with the following items that have been setup 

there previously and as shown in photo so that items are within reach: 
o CD or EF Hearing Aid Box  
o 3-way mirror with light on and close enough for participant to look into 
o iPad with Fitting App  
o Bose speaker sitting on top of yoga block  
o Call button 

• Show participant the iPad and the Call button and give these instructions: 
 
“Follow the instructions provided on the iPad to fit your hearing aids.  If the iPad stops 
working for some reason, you can use this Call button to get me.  When you have 
finished all the steps on the iPad, you will be instructed to press the Call 
button and I will come back to the room.”  

 
• Leave the room, close the door, and turn on the Call button receiver and leave it 

where it can be heard.   
• While waiting for participant, open Noah and ReSound SmartFit software (see 

section below and Appendix G for details). 
• Participant follows the instructions in the Fitting App 

When Call button is pressed, the AudU returns to fitting room with the other iPad that is 
open to REDCap. 
On the REDCap iPad, enter the data showing on the “Rx” page of the Fitting App. 
Keep the Fitting App iPad on and open to the Rx page to refer to later. 
REDCap will generate a Box Number with the appropriate hearing aid configuration for 
group, color, and wire length. 
Boxes numbered 7 to 12 are for the CD Group 
Boxes numbered 13 to 18 are for the EF Group. 
Take the box of hearing aids from the inventory corresponding to the generated Box 
Number 
If a box with that number is not available, contact the Central Office to be given an 
alternate number 
Put domes on the hearing aids corresponding to the size shown on Rx page.   
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Use the supply of domes provided for this that are in a large bag kept with the hearing 
aid inventory.  Be sure to select domes to match the receiver type on the aids:  black 
domes for original MP 2B receivers and gray domes for new MP 2C receivers.   
The small bag of 6 extra domes in 3 different sizes stays in the hearing aid box for the 
participant. 
• Take a photo of the box label with box number and bar code and upload to REDCap 
• Have participant sign gift card receipt on REDCap (they will be given the gift card 

during the Payment process) 

• Participants will be asked if they are a Northwestern Employee. 

• If participant selects “yes” a new set of fields will become available and 
should be completed. 

• If the participant is a temporary employee, print the linked DCFS form 
and obtain the participant’s signature.  Upload a photo of the DCFS 
form to REDCap 

• All REDCap data for this session has now been entered. You can close the tab 
on this iPad. 

• Bring iPad with Fitting App to the laptop with programming software. 

• Open Noah 
• If Error message is displayed, cancel and restart Noah 

• If Error message continues to display after repeated restarts, refer to Appendix I 

• Open ‘New Patient.’ 
Last Name = participant ID, First Name = CD or EF  
Do not enter any other information. 
Select OK 
Do not enter the audiogram because it is stored in the hearing aids. 

• Select ReSound SmartFit fitting module.   

• Power on hearing aids by removing from a charger or by pressing the buttons for 5 
seconds.  Listen for the 10 dings to indicate they are turning on.  

• Select “Connect” hearing aids.   

• Once discovered, check the left and right boxes and verify left and right by using 
“beep”.   Switch left and right if needed. 

• “Continue” 
• Message:  “Data Mismatch”;  Select “Read instrument Data” because you want the 

Fitting Data and Audiogram in the instrument to be loaded for this session. 

• “Continue”  
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• If message appears that aids need a firmware update to v.45, proceed with update. 

• If message appears that SOFTWARE needs to be updated, you will need to use the 
PC, not the laptop, to connect to the hearing aids, which have version 1.18 firmware.  
Refer to Appendix G for further information and contact the Project Manager for 
further instructions.   

• Select under View:(be sure to change this every time) 

• Stimulus Type = Speech weighted noise 

• Check hearing aid settings using the Clinician Report 

• Select “Summary>Clinician Report” 

• Scroll through Clinician Report and check that hearing aid settings match those 
provided in Appendix H or in the hard copies of Clinician Reports for groups CD 
and EF. 

• The most important settings are the gains for programs 1 to 4 and that DFS Ultra 
is set to Moderate in all 4 programs. 

• If the gains or DFS settings differ, contact the Project Manager for further 
instructions.  Appendix H also provides instructions on resetting the DFS. 

• Go back to “Fitting”  

• Select: Tools (with wrench in center right of screen)->Reorder Programs 
o Re-order the order of Programs P1 to P4 shown on Rx page of Fitting 

App.  Note that all programs are called “All Around”, so will need to keep 
track of order.   

o “Apply” 
o Double check that programs were moved to the correct order by looking at 

them in “Gain Adjustments” and if not in correct order, go back to Reorder 
Programs. 

• Reset Data Logging 
• Go to black menu bar: Fitting>Tools>Data Logging 

• Select “Reset”, then select “continue/Start” 

• Go back to “Fitting” 

• Select “Save”.  Message:  Saved to Database; Saved to Instrument. 

• Save Clinician Report 

• Select “Summary>Clinician Report” 
• Scroll through Clinician Report and confirm that order of the programs 

is correct 

• Select “Print” and when printer selection menu appears, select “print to 
pdf” and select file location on desktop 
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§ name file according to convention: 
§ S_<branch>_p<participant-id>_s<session number>_cr<clinician 

report> 
§ Example:  S_AB_p7_s1_cr.pdf 

 
• Go back to “Fitting” and select “Exit Smart Fit” 

• Reboot hearing aids by turning off/on using charger or pressing buttons on 
aids. 

• Hold aids in hands that are half open to check that feedback suppression is 
activated and that aids do not feedback.  A slight amount of feedback that 
then stops is normal.  

• Turn off hearing aids by holding button for 5 seconds until green light flashes 
3x 

• Wipe off aids with alcohol wipe. 

• Put hearing aids in pouch and put in the hearing aid box.  Put box in black 
ReSound bag.  Note that participant will NOT wear aids out of office.   

• Continue to Payment for Session 1 
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13.4.9 Payment for Session 1 [AudU] 

After Session 1, the unblinded audiologist will   
provide the $45 gift card ($25 for participation and $20 for travel reimbursement) 
remind participant that they will be contacted regarding Session 2 appointment, which 
will be in 6 weeks. 
 
To process payment/gift cards: 

• IF not already done, complete receipt on REDCap on iPad. 
o Participants will be asked if they are a Northwestern Employee. 
o If participant selects “yes” a new set of fields will become available and 

should be completed. 
o If the participant is a temporary employee, print the linked DCFS form and 

obtain the participant’s signature. 
o Upload a photo of the DCFS form on REDCap 
o Close REDCap tab on iPad. 

• Complete payment process on Clover device (for more, see Clover Tips 
document) 
• Enter your Clover device 

password. 

• Tap Register 
• Scan barcode on hearing aid 

box. 

• Scan barcode on $45 gift card. 
The participant receives $25 for 
completing the first session and 
$20 for travel reimbursement. 

• Tap Review Order. Make sure 
the correct tax is showing, and 
that gift card “costs” $0.00 

• Tap Pay 

• If participant is paying with credit/debit card: 
o Select Credit/Debit 
o Insert (chip), swipe (non-chip), or tap card (contactless). 
o Enter PIN – depending on the card, it might ask for signature instead. 
o Select Print Receipt 

If participant is paying with check: 
Select Check 
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Check should be made out to “Northwestern University” 
Make sure the check includes taxes ($637.50 + 2.25%, for IL 
participants) for a total of $650. 
In Note, please add Participant ID and ID number (driver’s license, 
passport, etc.) 
Select Print Receipt 
Checks will be mailed to and processed by the Coordinating Center in 
Evanston (Sumit Dhar, 2240 Campus Dr, Evanston, IL 60208). 

 
Hand the study bag to participant. Make sure it contains: 

• Hearing aid box 
• Gift card ($45) 
• Receipt 
• P-CHAT flyers 
• Troubleshooting Checklist 

 
REMIND PARTICIPANT: PLEASE REMEMBER TO USE YOUR HEARING 

AIDS FOR AT LEAST FOUR HOURS EACH DAY. 
 
Continue to Session 1 Wrap-Up 
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13.4.10 Session 1 Wrap-Up [AudU] 

Hearing aid data upload to REDCap 
For AB group:  move USB stick from Verifit to PC 
For all groups:  copy .pdf file with Clinician Report to USB stick in laptop and move 
USB stick to PC 
Open a browser on PC and go to 

https://redcap.nubic.northwestern.edu/redcap/surveys/ 

Use the second survey code provided to open REDCap 
Upload .xml file with Verifit data for AB group 
Upload .pdf file with Clinician Report data for all groups 
Close REDCap browser tab 

 
Check and charge devices 

o For CD and EF groups, check the charge level and plug in to charge as needed: 
Hearing aids in Self-fitting box (check charge using charger box) 
Remote controls in Self-fitting box (check charge by plugging in) 
Bose speaker (check by turning on) 
2 iPads (check indicator icon) 
• For all groups, check the charge level and plug in to charge as needed: 

Laptop 
Backup files monthly.  See Appendix J 
Otoscope 
Clover device 
Clean and store equipment 

o Wipe off all equipment and devices using alcohol-based cleaner; dispose of 
single-use items (probe tubes, insert phone eartips and specula) 
o Verifit equipment 
o Earphones 
o Self-fitting boxes and contents 
o iPads, laptop 
o Mirror 
o Clover device 
o Chairs and table tops 

o Turn off all devices and put in locked storage 
 

o Important information about Clover device: after checkout, store device in a 
secure location and never leave it charging overnight. Never share your 
password with others. 

  

https://redcap.nubic.northwestern.edu/redcap/surveys/
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13.5 Session 2 [AudU and AudB] 
• Participant reports to front desk in person or by phone following local COVID-19 

protocol. 
• Greet participant in the waiting area or at front door depending on local COVID-19 

protocol. 

13.5.1 Hearing Aid Measures and Questionnaires [AudU] 

• Activate the “REDCapSurveyPage” icon. 
o Do not close this tab till the end of the session when the participant has 

signed the receipt for gift card. 
• Enter the following from the confirmation email: 

o Session 2 Code  
o Participant ID  

 
To be conducted by AudU only 

Sanitize hands 

Ask participant Health and Doctor’s Visit questions in REDCap, 

 
• Inspect how the hearing aids are being worn on the participant.  

• If they do not have their hearing aids on, ask them to put them on and 
adjust them to how they usually use them 

• Remove the hearing aids and do an exam of the outer ears and otoscopy. 

• Inspect the hearing aids for damage or cerumen blockage but do NOT change, 
repair or charge aids at this step.   

• In REDCap enter the information for 

• Hearing aid placement and ear inspection 

• Otoscopy 

• Hearing aid inspection 
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Obtain on-ear speech mapping with the hearing aids as-is and at use 
settings/program.  

• Clear data in Verifit by selecting Session and choosing Erase All Data.  
This step can be skipped if Verifit was off and just turned on. 

• Go to Tests selection menu->On ear measures->Calibration  
§ Attach probe tubes and hold microphone 2-3 ft from speaker. 

Calibrate right and left microphones. 
• Tests selection menu->On ear measures->SpeechMap  

• Change drop-down menus:  
§ Dual-view 
§ On-ear and RITE 
§ Open  

• Select “Audiometry” and select  
§ NAL-NL2  
§ Adult  
§ Transducer = Insert + foam  
§ Binaural = No (note: this is the opposite of what you would assume, 

but we are using NO BINAURAL here due to differences in Smart 
Fit and Verifit’s target generation.)  

§ Language Non tonal  

• Select “Continue”.  You do not need to enter the audiogram. 

• Place probe tubes in participant’s ears  
• Put aids in ears and complete Test 1 for each ear: 

§ Select Test 1:  ISTS/ Avg (65) 
 
 

• Save Verifit Session data #1: 
• Press “Session” button.  Select “Store Session to File.” 
• Enter name of file by clicking on box next to “View & Search” and then 

typing on keyboard and using this naming convention: 
i. V_<branch>_p<participant-id>_s<session number>_<test 

number> 
ii. Example:  V_AB_p7_s2_1.xml 

• Save the Session data to the USB drive.   
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• Perform Inspection and Maintenance on hearing aids and enter findings in 
REDCap 

• DO NOT do this where the participant can see what is being done, as 
this could influence PHAST-R results. 

• Do a listening check on hearing aids to determine Program being used. 
• Put hearing aids in a charger to check battery levels.  If not charged, 

charge until sufficient for testing.  Take out of charger.   

• Clean or replace any domes or wax filters if blocked with cerumen.   

• Replace any damaged receiver wires 

• DO NOT provide any instruction/re-instruction to participant regarding 
use/care of hearing aids at this point in the session. A structured protocol 
to address this will be available later in the session. 

o Set aids to Program 1 and complete on-ear speech mapping for each ear: 
• Select Test 1: ISTS/ Avg (65) 

• Select Test 2: ISTS/ Soft (55). 

• Select Test 3: ISTS/Loud (75) 
o MPO/LDL measurement: use instructions and categories on printed sheet. 

Link to MPO_LDL document 
 

 
Instructions: 
 
“The purpose of this test is to determine if your hearing aids are set so that sounds get 
what you feel is ‘Uncomfortably Loud’. Here are categories of sound that describe 
loudness, from ‘Very Soft’ up to ‘Uncomfortably Loud’. We know that sometimes sounds 
are ‘Loud but OK’ but we do not want them to be ‘Uncomfortably Loud.’ I am going to 
play out a sound that will be changing in pitch. Raise your hand or tell me to stop the 
sound if you feel that it is “Uncomfortably Loud”. If it is “Loud, but OK”, then do not tell 
me to stop.” 
 

 
Categories of Loudness: 

• Uncomfortably loud 

• Loud, but okay 

• Comfortable, but slightly loud 

• Comfortable 
• Comfortable, but slightly soft 

https://nuwildcat.sharepoint.com/:w:/r/teams/gl_SOC_DharPICORI/_layouts/15/Doc.aspx?sourcedoc=%7BE34599C9-D93B-45D4-9575-D0D2EE8A7079%7D&file=MPO_LDL-Procedure.docx&action=default&mobileredirect=true&wdLOR=cFE71B92F-B861-F94B-A261-A9B2638F9BEB&cid=d0828746-55e3-488e-8b0b-ee2fc250f4c1
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• Soft 

• Very soft 
 

• Select Test 4 = MPO/85 dB SPL 

• Note in REDCap if participant indicated that the signal was “Uncomfortably 
loud” 

• Do NOT return hearing aids to participant until PHAST-R testing 
 
Aided Questionnaires 

• Hand iPad to participant and instruct them to answer questions till they arrive 
at a screen that asks them to hand the iPad back to the audiologist. 
The participant will complete these questionnaires on REDCap without 
assistance: 

• Aided PHAP 
• Aided HHIE 
• MARS-HA 

 

• For AB Group, skip to Save Verifit Data 
• For CD and EF Groups, do NOT save Session data #2 until after test box 

measures are completed. 
 
For CD and EF Groups Only 
Obtain test-box measures 
 

• Set hearing aids to Program 1 and put in 2cc or .4cc couplers 

• On Verifit, press Tests button to go to Tests selection menu>Test box 
measures>Speechmap  

Select Test 1:  Speech ISTS /Avg (65)   

• Select Test 2:  Speech ISTS/ Soft (55)  

• Select Test 3:  Speech ISTS/ Loud (75) 
• Select Test 4:  MPO 90 

 
For All Groups 

• Save Verifit Data #2: 
• Press “Session” button.  Select “Store Session to File.” 
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• Enter name of file by clicking on box next to “View & Search” and then 
typing on keyboard and using this naming convention: 

• V_<branch>_p<participant-id>_s<session number>_test number> 
• Example:  V_AB_p7_s2_2.xml 

• Select “Continue” 
• Will see message: “Accessing USB stick. Please wait.”   
 

• Download and save Datalogging data from aids 
• Open Noah software on laptop 

§ Select Participant by their ID number (Last Name) and Group 
AB/CD/EF (First Name) 

• Open ReSound Smart Fit fitting module. 
• Put hearing aids in charger and then power on hearing aids by removing 

from charger   
• “Connect” hearing aids.   
• Once discovered, check boxes for left and right aids and verify left and 

right by using “beep”.  
• “Continue” 
• Select “Read Instrument Data” 

• “Continue” 

• Select “SAVE” to save data to database.  Return to Fitting. 
• Select “Fitting” (in top black tool bar)>Tools>Datalogging 
• Take 2 screenshots of Datalogging data (press the “Windows”+”PrtSC” 

keys together on your keyboard.  The screen will briefly fade when screen 
is captured): 

First screen includes “Total Hours” and “Average use time per day” and “Use 
Time Per Program”. 
To get the second screen, go to “Observations” and click on the icon of 
overlapping squares  to get “Hours spent in different listening environments.”  
If this is not available, skip to the next step.  If second screen is available, take a 
screenshot of that screen. 

 
 
• Go back to “Gains” screen 

• Save “Clinician Report” 
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• Go to “View” and change “Stimulus Type” to “Speech Weighted Noise” 

• Select “Summary>Clinician Report” 
“Print” report and when print menu appears, select “to a .pdf file” and select 
location on laptop. 
 name file according to convention: 
S_<branch>_p<participant-id>_s<session number>_cr<clinician report> 
Example:  S_AB_p7_s1_cr.pdf 

• “Save” 
•  Exit from Smart Fit 
• Reboot hearing aids by putting them in/out of charger 

• To find the Datalogging Screenshots, go to the “Pictures” folder in your Windows 
Explorer window. You will see a folder named “Screenshots” inside.  

• The files will be named "Screenshot (N)". These will need to be renamed 
following the file naming convention 

For Datalogging screenshots 
S_<branch>_p<participant-id>_s<session number>_<screenshot number> 
Example: 
S_AB_p7_s2_1.png 
S_AB_p7_s2_2.png 

• Move USB stick from Verifit to a PC (NOT the laptop with Noah) and locate the 2 
current Session .xml files using Windows Explorer 

• Copy current Clinician Report .pdf files and the Datalogging .png files on the laptop 
to a USB stick.  Move the USB stick from laptop to a PC and locate the files.  

• Open a browser on the PC and go to 

• https://redcap.nubic.northwestern.edu/redcap/surveys/ 
Use the second survey code provided to open REDCap 
Upload two .xml files with Verifit data  
Upload .pdf file with Clinician Report data 
Upload two .png files with Datalogging data 

• Close REDCap browser tab 
 

• Wipe aids with alcohol wipes 
• When participant has completed questionnaires, return hearing aids to participant 

and instruct them to put aids on. 
• Go to Administer PHAST-R  

https://redcap.nubic.northwestern.edu/redcap/surveys/
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13.5.2 Administer PHAST-R [AudB] 

• AudU informs AudB that participant is ready for PHAST-R and hands iPad over 
with REDCap on PHAST-R screen 
• AudB sanitizes hands 

• Participant is seated at a table set up with the following: 
o Hearing aid charger (fully charged) 
o Tissues 
o Cleaning tool 
o Wax guards 
o Telephone 

• AudB administers PHAST-R (see Appendix E) and enters results into 
REDCap 

• AudB returns iPad to AudU 

13.5.3 Check Hearing Aid Problems Inventory [AudU] 

Ask the participant, “Have you been having any problems with your hearing aids? [If 
Yes] What are they? 

• Complete the inventory on REDCap to mark each problem that the participant 
reports. 

• Mark the appropriate sections on a hard copy of the Trouble Shooting Guide. 

• Ask if participant still has the user’s manual. Provide new copy if they do not. 

Problems charging the hearing aids? R__  L__  p.13-15 
Problems putting the aids in your ears?  R__  L__  p.18 
Problems removing the aids? R__  L__  p.18 
Problems with the hearing aids whistling or buzzing? R__  L__  p.18 
Problems changing the program in the aids?  p.21 
Hearing aids are not loud enough? p.21 
Hearing aids sound too loud? p.21 
Hearing aids sound too tinny? p.21 
Hearing aids sound distorted? p.13-15 
Problems changing the domes? p.29 
Problems changing the wax guards? p33 
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Problems keeping aids in ears?  Audiologist can install Sport Lock on aids if 
needed 

Ask the participant, “Are you going to keep your hearing aids?  
 If “Yes”, keeping hearing aids: 

• Continue to 13.5.4 Payment for Session 2 
If “No”, not keeping hearing aids:  

• Read Instructions and Participant Debriefing Script in REDCap. 
• Complete repeat audiogram and enter results in REDCap following instructions 

• Complete Exit form in REDCap following instructions 

•  Continue to 13.5.4 Payment for Session 2 

• Follow instructions for Refunding Payment in next section. 
After participant leaves, continue to Session 2 Wrap-Up 

 

13.5.4 Payment for Session 2 

After Session 2, AudU will   
provide the $20 travel reimbursement gift card 
remind participant that they will be contacted to have Session 3 scheduled 

 
To process gift card: 

• Complete receipt on REDCap 
o Participants will be asked if they are a Northwestern Employee. 
o If participant selects “yes” a new set of fields will become available and 

should be completed. 
o If the participant is a temporary employee, print the linked DCFS form and 

obtain the participant’s signature. 
o Upload a photo of the DCFS form on REDCap 

• Complete payment process on Clover device (for more, see Clover Tips 
document) 

o Enter your Clover device password. 
o Tap Register 
o Scan $20 travel reimbursement gift card. 
o Tap Review Order. Make sure gift card “costs” $0.00. 
o Tap Pay 
o Select Check 
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o In Note, please add Participant ID 
o Select Print Receipt 
o Hand gift card and receipt to participant. 

 
REMIND PARTICIPANT: PLEASE REMEMBER TO USE YOUR HEARING AIDS 

FOR AT LEAST FOUR HOURS EACH DAY. 
 

• Refunding Payment:  If participant is returning the hearing aids, a refund needs 
to be processed for the $650 on the Clover device.  For more details, see Clover 
Tips document.   

o Enter your Clover device password. 
o Open the Refund app. 
o REDCap will display the date of Session 1 that order was placed 
o If Session 1 was less than 30 days prior, select “Look Up Past Payment” 

and transactions will be displayed by date from most recent; scroll to find 
date. 

§ Tap transaction and confirm name and last digits of card number 
are correct by selecting “Details”. 

§ Select REFUND button. 
o If Session 1 was more than 30 days prior (which most will be),the 

transaction will not appear; Enter amount to refund manually:  
•  $635.70 + $14.30 tax = $650.00 total 

• Select Issue Refund 

• Enter credit or debit card number, expiration date, and CVV 

• If a check was used for payment, select Cash refund and notify P-
CHAT office that a refund check needs to be sent to participant.  
Tell participant that they will receive a check from NU within a few 
weeks. 

o Print and provide receipt for refund to participant. 
o Take the box of aids with charger from participant to be returned. 

 
When participant leaves, continue to Session 2 Wrap-Up 
 

13.5.5 Session 2 Wrap-Up [AudU] 

Check and charge devices: 
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• Otoscope 

• Hearing aid charger 

• Clover device 

• Laptop 
Backup files monthly.  See Appendix J 

 
 
Clean and store equipment 

o Wipe off all equipment and devices using alcohol-based cleaner; dispose of 
single-use items (probe tubes and specula): 
o Verifit equipment 
o iPads and laptop 
o Clover device 
o Chairs and table tops 

o Turn off all devices and put in locked storage 
 

Important information about Clover device: after checkout, store device in a 
secure location and never leave it charging overnight. Never share your 
password with others. 
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13.6 Session 3 [AudU and AudB] 
• Participant reports to front desk in person or by phone following local COVID-19 

protocol. 
• Greet participant in the waiting area or at front door depending on local COVID-

19 protocol. 

13.6.1 Hearing Aid Measures and Questionnaires [AudU] 

• Activate the “REDCapSurveyPage” icon. 
Do not close this tab till the end of the session when the participant has signed 
the receipt for gift card. 

• Enter the following from the confirmation email: 
o Session 3 Code  
o Participant ID  

 
To be conducted by AudU only 

Sanitize hands 
Ask participant Health and Doctor’s Visit questions in REDCap,  

• Inspect how the hearing aids are being worn on the participant.  

• If they do not have their hearing aids on, ask them to put them on and 
adjust them to how they usually use them 

• Remove the hearing aids and do an exam of the outer ears and otoscopy.   

• Inspect the hearing aids for damage or cerumen blockage but do NOT change, 
repair or charge aids at this step.   

• In REDCap enter the information for 

§ Hearing aid placement and ear inspection 

§ Otoscopy 

§ Hearing aid inspection 

 
Obtain on-ear speech mapping with the hearing aids as-is and at use 
settings/program. 

• Clear data in Verifit by selecting Session and choosing Erase All Data.  
This step can be skipped if Verifit was off and just turned on. 

• Go to Tests selection menu->On ear measures->Calibration  
§ Attach probe tubes and hold microphone 2-3 ft from speaker. 

Calibrate right and left microphones. 
• Tests selection menu->On ear measures->SpeechMap  

• Change drop-down menus:  
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§ Dual-view 
§ On-ear and RITE 
§ Open  

• Select “Audiometry” and select  
§ NAL-NL2  
§ Adult  
§ Transducer = Insert + foam  
§ Binaural = No (note: this is the opposite of what you would assume, 

but we are using NO BINAURAL here due to differences in Smart 
Fit and Verifit’s target generation.)  

§ Language Non tonal 

• Select “Continue”.  You do not need to enter the audiogram. 

• Place probe tubes in participant’s ears  

• Put aids in ears and complete Test 1 for each ear: 
§ Select Test 1:  ISTS/ Avg (65) 

 
 

• Save Verifit Session data #1: 
• Press “Session” button.  Select “Store Session to File.” 
• Enter name of file by clicking on box next to “View & Search” and then 

typing on keyboard and using this naming convention: 
I. V_<branch>_p<participant-id>_s<session number>_<test 

number> 
II. Example:  V_AB_p7_s3_1.xml 

• Save the Session data to the USB drive.   
 

• Perform Inspection and Maintenance on hearing aids and enter findings in 
REDCap 

• DO NOT do this where the participant can see what is being done, as 
this could influence PHAST-R results. 

• Do a listening check on hearing aids to determine Program being used. 
• Put hearing aids in a charger to check battery levels.  If not charged, 

charge until sufficient for testing.  Take out of charger.   

• Clean or replace any domes or wax filters if blocked with cerumen.   

• Replace any damaged receiver wires 



Version 3.2  -  October 4, 2022   Page 59 of 124 
 

• DO NOT provide any instruction/re-instruction to participant regarding 
use/care of hearing aids during this session. 

o Set aids to Program 1 and complete on-ear speech mapping for each ear: 

• Select Test 1: ISTS/ Avg (65) 

• Select Test 2: ISTS/ Soft (55). 

• Select Test 3: ISTS/Loud (75) 
o MPO/LDL measurement: use instructions and categories on printed sheet. 

Link to MPO_LDL document 
 

 
Instructions: 
 
“The purpose of this test is to determine if your hearing aids are set so that sounds get 
what you feel is ‘Uncomfortably Loud’. Here are categories of sound that describe 
loudness, from ‘Very Soft’ up to ‘Uncomfortably Loud’. We know that sometimes sounds 
are ‘Loud but OK’ but we do not want them to be ‘Uncomfortably Loud.’ I am going to 
play out a sound that will be changing in pitch. Raise your hand or tell me to stop the 
sound if you feel that it is “Uncomfortably Loud”. If it is “Loud, but OK”, then do not tell 
me to stop.” 
 

 
Categories of Loudness: 

• Uncomfortably loud 

• Loud, but okay 
• Comfortable, but slightly loud 

• Comfortable 

• Comfortable, but slightly soft 

• Soft 

• Very soft 
 

• Select Test 4 = MPO/85 dB SPL 

• Note in REDCap if participant indicated that the signal was “Uncomfortably 
loud” 

• Do NOT return hearing aids to participant until PHAST-R testing 
 
 

https://nuwildcat.sharepoint.com/:w:/r/teams/gl_SOC_DharPICORI/_layouts/15/Doc.aspx?sourcedoc=%7BE34599C9-D93B-45D4-9575-D0D2EE8A7079%7D&file=MPO_LDL-Procedure.docx&action=default&mobileredirect=true&wdLOR=cFE71B92F-B861-F94B-A261-A9B2638F9BEB&cid=d0828746-55e3-488e-8b0b-ee2fc250f4c1
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Aided Questionnaires 
• Hand iPad to participant and instruct them to answer questions till they arrive at a 

screen that asks them to hand the iPad back to the audiologist. 
• The participant will complete these questionnaires without assistance: 

• Aided PHAP 
• Aided HHIE 
• MARS-HA 
 

• Save Verifit Session data #2: 
• Press “Session” button.  Select “Store Session to File.” 
• Enter name of file by clicking on box next to “View & Search” and then 

typing on keyboard and using this naming convention: 

• V_<branch>_p<participant-id>_s<session number>_test 
number> 

• Example:  V_AB_p7_s3_2.xml 
• Save the Session data to the USB drive.   

 
• Download and save data logging data from aids 

• Open Noah software on laptop 
§ Select Participant by their ID number (Last Name) and Group 

AB/CD/EF (First Name) 
• Open ReSound Smart Fit fitting module. 
• Put hearing aids in charger and then power on hearing aids by removing 

from charger   
• “Connect” hearing aids.   
• Once discovered, check boxes for left and right aids and verify left and 

right by using “beep”.  
• “Continue” 
• Select “Read Instrument Data” 
• “Continue” 

• Select “SAVE” to save data to database.  Return to Fitting. 
 

• Select “Fitting” (in top black tool bar)>Tools>Datalogging 
o Take 2 screenshots of Datalogging data (press the “Windows”+”PrtSC” 

keys together on your keyboard.  The screen will briefly fade when screen 
is captured): 

§ First screen includes “Total Hours” and “Average use time per day” 
and “Use Time Per Program”. 
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§ To get the second screen, go to “Observations” and click on the 
icon of overlapping squares  to get to “Hours spent in different 
listening environments.”  If this is not available, skip to the next 
step.  If second screen is available, take a screenshot of that 
screen. 

 
• Go back to “Gains” screen 

• Save “Clinician Report” 
• Go to “View” and change “Stimulus Type” to “Speech Weighted Noise” 

• Select “Summary>Clinician Report” 

“Print” report and when print menu appears, select “to a .pdf file” and select 
location on laptop. 
 name file according to convention: 
S_<branch>_p<participant-id>_s<session number>_cr<clinician report> 
Example:  S_AB_p7_s1_cr.pdf 

• “Save” 

•  Exit from Smart Fit 

• Reboot hearing aids by putting them in/out of charger 
 

• To find the Datalogging Screenshots, go to the “Pictures” folder in your Windows 
Explorer window. You will see a folder named “Screenshots” inside.  

o The files will be named "Screenshot (N)". These will need to be renamed 
following the file naming convention 

• For Datalogging screenshots 
• S_<branch>_p<participant-id>_s<session 

number>_<screenshot number> 

• Example: 

• S_AB_p7_s2_1.png 

• S_AB_p7_s2_2.png 
• Move USB stick from Verifit to a PC (NOT the laptop with Noah) and find the 2 

current session .xml files on the USB using Windows Explorer 
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• Copy current Clinician Report .pdf files and the Datalogging .png files on the 
laptop to a USB stick.  Move the USB stick from laptop to a PC and locate the 
files.  

• Open a browser on the PC and go to 
o https://redcap.nubic.northwestern.edu/redcap/surveys/ 

§ Use the second survey code provided to open REDCap 
§ Upload two .xml files with Verifit data  
§ Upload .pdf file with Clinician Report data 
§ Upload two .png files with Datalogging data 

• Close REDCap browser tab 
• Wipe aids with alcohol wipes 

• When participant has completed questionnaires, return hearing aids to participant 
to put on 

• Go to Administer PHAST-R 

13.6.2 Administer PHAST-R and Hearing Test [AudB] 

• AudU informs AudB that participant is ready for PHAST-R and hands iPad over 
with REDCap on PHAST-R screen 
• AudB sanitizes hands 
• Participant is seated at a table set up with the following: 

o Hearing aid charger (fully charged) 
o Tissues 
o Cleaning tool 
o Wax guards 
o Telephone 

• AudB administers PHAST-R (see Appendix E) and enters results into 
REDCap 

 
Audiogram 
• AudB escorts participant into test booth and gives instructions for puretone 

AC testing.   
• Use insert earphones 
•  Obtain air conduction thresholds in each ear at the following frequencies, 

using masking as necessary 
• Use a black pen and record the responses on the Audiogram form at: 
 

§ 250 
§ 500 
§ 1000 
§ 2000 
§ 3000 

https://redcap.nubic.northwestern.edu/redcap/surveys/
https://redcap.nubic.northwestern.edu/redcap/surveys/
https://nuwildcat.sharepoint.com/:w:/r/teams/gl_SOC_DharPICORI/_layouts/15/Doc.aspx?sourcedoc=%7B21FB9C02-847B-4583-A1CD-5D00A0A98130%7D&file=Audiogram.docx&action=default&mobileredirect=true&cid=e8004bee-f64e-4d1c-8b5a-f992b9f64e29
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§ 4000 
§ 6000 
§ 8000 

• Enter thresholds into REDCap. After the thresholds are entered for the first 
ear, they will be copied and displayed for the second ear.  These thresholds 
can be modified to reflect those measured. 

• After thresholds are entered for both ears, the PTA for this test and the test 
obtained during Session 1 will be displayed to determine if there is a change 
in hearing. 

• Scan paper audiogram into REDCap. Store the paper audiogram in a secure 
file. 

• AudB returns the iPad to the AudU. 
 

13.6.3 Check Hearing Aid Problems Inventory [AudU] 

AudU asks the participant, “Have you been having any problems with your hearing 
aids? [If Yes] What are they?” 

• Complete the inventory on REDCap to mark each problem that the participant 
reports. 

• Mark the appropriate sections on a hard copy of the Trouble Shooting Guide. 

• Ask if participant still has the user’s manual. Provide new copy if they do not. 

1. Problems charging the hearing aids? R__  L__  p.13-15 
2. Problems putting the aids in your ears?  R__  L__  p.18 
3. Problems removing the aids? R__  L__  p.18 
4. Problems with the hearing aids whistling or buzzing? R__  L__  p.18 
5. Problems changing the program in the aids?  p.21 
6. Hearing aids are not loud enough? p.21 
7. Hearing aids sound too loud? p.21 
8. Hearing aids sound too tinny? p.21 
9. Hearing aids sound distorted? p.13-15 
10. Problems changing the domes? p.29 
11. Problems changing the wax guards? p33 

12. Problems keeping aids in ears?  Audiologist can install Sport Lock on aids if 
needed 

13.6.4 Debriefing (AudU) 

• The Unblinded audiologist debriefs the participant following the Debriefing 
Script in REDCap.   

https://nuwildcat.sharepoint.com/:w:/r/teams/gl_SOC_DharPICORI/_layouts/15/Doc.aspx?sourcedoc=%7B9FC87601-5260-4859-9810-1CC0E457A314%7D&file=Debriefing.docx&action=default&mobileredirect=true
https://nuwildcat.sharepoint.com/:w:/r/teams/gl_SOC_DharPICORI/_layouts/15/Doc.aspx?sourcedoc=%7B9FC87601-5260-4859-9810-1CC0E457A314%7D&file=Debriefing.docx&action=default&mobileredirect=true
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• The Participant signs the acknowledgment page. 
 

13.6.5 Payment for Session 3 

After Session 3, AudU will provide  
$95 gift card ($75 for study completion and $20 travel reimbursement) 
 
To process participant compensation: 

• Complete receipt on REDCap 
o Participants will be asked if they are a Northwestern Employee. 
o If participant selects “yes” a new set of fields will become available and 

should be completed. 
o If the participant is a temporary employee, print the linked DCFS form and 

obtain the participant’s signature. 
o Upload a photo of the DCFS form on REDCap 

• Complete payment process on Clover device (for more, see Clover Tips 
document) 

o Enter your Clover device password. 
o Tap Register 
o Scan $95 gift card 
o Tap Review Order. Make sure gift card “costs” $0.00. 
o Tap Pay 
o Select Check 
o In Note, please add Participant ID 
o Select Print Receipt 
o Hand gift card and receipt to participant. 

 
 

13.6.6 Session 3 Wrap-Up (AudU) 

Check and charge devices 
Otoscope 
Hearing aid charger 
Clover device 
Laptop 
Backup files monthly.  See Appendix J 
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Clean and store equipment 

o Wipe off all equipment and devices using alcohol-based cleaner; dispose of 
single-use items (probe tubes and specula) 
o Verifit equipment 
o Earphones 
o iPads and laptop 
o Clover device 
o Chairs and table tops 

o Turn off all devices and put in locked storage 
 

Important information about Clover device: after checkout, store device in a 
secure location and never leave it charging overnight. Never share your 
password with others. 
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14.0 Hearing Aid Handling 

14.1 Hearing Aid Registration  
Within 48 hours of the end of a Session 1, a P-CHAT team member will contact the 
ReSound to register the hearing aids to the participant. This will be done by providing 
the participant’s name, , hearing aid serial numbers, and date of fitting.  Registering the 
hearing aids to the participant is necessary to activate the manufacturer repair warranty 
should service to the devices become necessary.   

14.2 Contact Regarding Hearing Aid Problems  
• If participant contacts the P-CHAT office following Session 1 or 2 and reports 
hearing aid problem(s), the following steps will be followed:  

• Team member will ask participant to first review their User Guides for 
assistance.  They will refer the participant to specific page numbers in the 
guides for their problems.  
• If the problem persists, and it is just for one hearing aid, have the participant 
remove both hearing aids and compare the functioning hearing aid to the non-
functioning hearing aid in terms of battery charge, receiver wire, waxguard or 
dome (e.g., plugged with wax?).  
• If participant cannot resolve issue, they will be scheduled at their study 
site at their earliest convenience.  

  

14.2.1 Hearing Aid Repairs  

If AudU determines that a participant’s hearing aid(s) needs repair, AuDU will first 
attempt to perform the repair as appropriate. If the device(s) needs to be sent to the 
manufacturer for repair, AuDU will follow regular procedures at the site to arrange for 
such repair.  
  
If the participant is in between Sessions 1 and 2, AuDU will:  

• Program a hearing aid of the same color and receiver wire to match the 
settings of the hearing aid to be repaired.  
• Link the new hearing aid to the participant record.  
• Record the box number from which the new hearing aid was extracted.  
• Send the hearing aid needing repair to the manufacturer with instructions not 
to update the firmware in the aid.  

  
A team member at the CC will:  

• Call the manufacturer to delink the broken hearing aid from the participant.  
• Link the new hearing aid to the participant by registering the new 
serial number.  

  
When the repaired hearing aid is returned to the site, AudU will verify whether or not the 
serial number of the device(s) has changed and will report that to the CC. AudU 
will reprogram the repaired aid to the appropriate settings and then put the hearing aid 
into the box from which the replacement hearing aid was extracted.  
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If the participant is in between Sessions 2 and 3, the AudU will follow regular 
procedures at the site to arrange for such repair. No replacement aid will be provided. 
AudU will inform the participant that he/she will be contacted when the repair is 
completed. AudU will arrange for the participant to receive the repaired hearing aid 
either through a scheduled visit or via an alternate arrangement acceptable to the 
participant.   
  
AudU will log the visit and describe the repair need using the Unscheduled Visit form. If 
a replacement device is provided, the serial number of the new device will be 
documented in the form.  

14.2.2 Unscheduled Visit  

Unblinded Audiologist (AudU) will inspect hearing aid using the Unscheduled 
Visit form in REDCap for obvious problems (one checklist per hearing aid) and 
correct the problem.  
If no problem in hearing aid function is discovered, AudU will take the 
participant to the booth area for otoscopy, tympanometry, etc. as needed to 
attempt to determine underlying issue.  
Log all inquiries, noting the problem, additional unscheduled visits (if needed), 
and the final resolution.  

  

14.3 Dome in Ear Canal  
If a participant contacts CC to report that a dome has become detached from the 
receiver and has remained in the ear canal:  

• Assure the participant that the dome can be easily removed and should be 
removed at the earliest convenience.   
• Schedule an appointment for the participant at the nearest clinical site by 
calling the front desk or scheduling contact while the participant is on hold so 
that the appointment can be confirmed on the phone.  
• Complete the Adverse Event form in REDCap  

  
The clinical site will also complete the Unscheduled Visit form in REDCap after the 
participant’s appointment and report the outcome of the removal attempt and any 
instructions.  
  

14.4 Troubleshooting Phone Call Protocol  
If a participant calls the CC using the toll-free number about a hearing aid problem, the 
phone call will be fielded by one of the trained AuD students on Jabber. The phone 
schedule is overseen by the Research Assistant (Kayla Gray) with trained AuD students 
working shifts to answer the call. The student research assistants will follow the script 
below to answer questions and guide the participant. Student research assistant will 
guide the participant to the appropriate page of the user manual and ask them to follow 
the directions on the page.   

bookmark://_15.1_Additional_Forms/
bookmark://_15.1_Additional_Forms/
bookmark://_15.1_Additional_Forms/
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In cases where the problem is not resolved over the phone with the limited guidance 
allowable in the protocol, the student research assistant will ask the participant to hold 
and transfer the call to the full-time RA for scheduling a visit to the clinical site. The 
appointment for the “walk in” will be scheduled during a regularly scheduled session 1 at 
the site.  
  
Issue:  Possible cause:  Possible solution:  User 

Guide 
Page:  

No 
sound  

Hearing aid not 
turned on  

• Turn hearing aid on        17  

Not charged  • Charge hearing aid  
• Make sure the charger is charged  

      13-15  

Blocked wax 
guard or dome  

• Replace wax guard and/or dome        33, 29  

Broken/twisted 
receiver wire  

Call P-CHAT office at 877-884-5242.     

Blocked ear canal  • Consult with your primary doctor or other 
preferred provider for ear cleaning  

  

Not loud 
enough  

Improper insertion 
of hearing aid  

Re-insert the hearing aid       18  

Occluded wax 
guard or dome  

• Replace wax guard and/or dome        33, 29  

Insufficient 
volume  

• Try another program                                21  

Blocked ear canal  • Consult with your primary doctor or other 
preferred provider for ear cleaning  

  

Excessive 
whistling/ 
feedback  

Improper insertion 
of hearing aid  

Re-insert the hearing aid dome so that it is 
completely in the ear canal  

18  

Blocked ear canal  • Consult with your primary doctor or other 
preferred provider for ear cleaning  

  

Distorted/ 
poor 
sound 
quality  

Low charge   
  

• Charge hearing aid  
• Make sure the charger is charged  
  

      13-15  

Broken/twisted 
receiver wire  

Call P-CHAT office at 877-884-5242    

Too loud    Try another program        21  

Too tinny    • Try another program        21  

Noise is 
too loud  

  Try another program        21  

  
The student research assistant will also complete the Unscheduled Visit 
form in REDCap to report the reason for the phone call and the outcome.  
  
 

bookmark://_15.1_Additional_Forms/
bookmark://_15.1_Additional_Forms/
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15.0 Exit Protocol 
At each stage of the study, there are points at which the participant may choose to exit 
the study. If appropriate, research team members can encourage participants to remain 
in the study. The following outlines the various points where exit from the study may 
occur.  When this happens, the Exit form and Gift Card Receipt form in REDCap need 
to be completed. 
 
• Session 1 screening 

Does not qualify 
Complete exit form (select exit at “Screening”) 
Qualifies but decides not to continue  
Complete exit form (select exit at “Session 1”) 

 
• Session 1 data 

1. Decides not to continue with hearing aids before fitting 
i. Complete exit form. Include details about exit reason(s). 

2. Decides not to continue with hearing aids after fitting 
i. Encourage to try hearing aids till Session 2 
ii. Remind that they can get a complete refund at Session 2 
iii. Complete exit questionnaire if participant still wants to withdraw 
 

• Session 1 no show 
3. Coordinating center calls and attempts to reschedule 

If unreachable or unwilling to reschedule 
Complete exit questionnaire on the phone 

 
• Calls to cancel Session 2 appointment 

4. Encourage to keep Session 2 appointment 
Provide hearing aid return instructions to Coordinating Center 
Inform that $650 will be returned once hearing aids are received 
Complete exit questionnaire if participant still wants to withdraw 

 
• Session 2 

5. Hearing aid returned 
Audiogram 
Fill out exit questionnaire if participant still wants to withdraw 

6. Hearing aid not returned but will not return for session 3 
Encourage to keep session 3 appointment 
Remind about $75 completion gift card 
Audiogram 
Fill out exit questionnaire if participant still wants to withdraw 

 
• Session 2 No Show 

7. Coordinating center calls and attempts to reschedule 
If unreachable or unwilling to reschedule 
Complete exit questionnaire on the phone 
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• Calls to cancel Session 3 appointment 

8. Encourage to keep session 3 appointment 
Remind about $75 completion gift card 
Fill out exit questionnaire if participant still wants to withdraw 

 
• Session 3 Completes study 

Audiogram 
Fill out exit questionnaire 

 
• Session 3 No show 

9. Coordinating center calls and attempts to reschedule 
If unreachable or unwilling to reschedule 
Complete exit questionnaire on the phone 

 

15.1 Additional Forms in REDCap  
The following forms are available in REDCap: 
Gift Card Receipt (different receipts for Sessions 1, 2, 3, and Unscheduled Visits) 
Exit Form 
Adverse Event Reporting Form 
Unblinding Reporting Form 
Unscheduled Visit Checklist 
Protocol Deviation Form 
 
To access these forms: 

• Connect to NU VPN using the “GlobalProtect” icon on the iPad homescreen if 
you are not at NU. 

• Select the “REDCap Login” icon on the iPad homescreen. 
• Log into REDCap using your NetID and password. 
• Click on “Add/Edit Records” 
• “Choose an existing Record ID” using the drop-down menu 
• Select the desired form.  For Gift Card Receipts, select the receipt for the 

session, “1-”, “2-”, “3-” or “Extra” and verify the correct $ amount is on the form 
selected 

• Complete all sections of the form.  Provide additional details in the Notes box 
when available.  

• Mark the form as “Complete” when done 
• Click on “Save & Exit Form”  
• Exit REDCap when all forms are completed 

16.0 Timeline and visit schedule 
The study is completed over three sessions. The first session is used for screening and 
baseline measures. Two follow up sessions are conducted 6 weeks and 6 months after 
the baseline session. Measures scheduled for each session are listed in Appendix C. 
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17.0 Scope/Schema 
Step-by-step directions for each session are provided in the sections linked below: 

• Session 1 
• Session 2 
• Session 3 

18.0 Safety Reporting 

18.1 Database Protection  
All data will be stored on secure cloud servers using a REDCap database. The 
database will be secured with password protection. Electronic communication with 
outside collaborators will involve only unidentifiable information. Data recorded on paper 
will be entered into the database and verified by two independent research assistants. 
Paper forms will be stored in locked cabinet with only the Project Manager having 
access to the cabinet. The PIs will seek permission from the DSMB before accessing 
these forms under any circumstance.  

18.2 Confidentiality During Adverse Event (AE) Reporting  
AE reports and annual summaries will not include subject-identifiable material. Each 
report will only include the identification code.  

18.3 Adverse Event Information  
Definition    An adverse event (AE) is any untoward occurrence in a subject during 
participation in the study. An adverse finding can include a sign, symptom, abnormal 
assessment, or any combination of these.  
  A serious adverse event (SAE) is any adverse event that results in one or more of the 
following outcomes:  

• Death 
• A sudden change in hearing, either perceived or measured 
• A life-threatening event  
• Inpatient hospitalization or prolongation of existing hospitalization  

18.4 Classification of AE Severity  
AEs will be labeled according to severity, which is based on their impact on the patient. 
An AE will be termed “mild” if it does not have a major impact on the patient, “moderate” 
if it causes the patient some minor inconvenience, and “severe” if it causes a substantial 
disruption to the patient’s well-being.  

18.5 AE Attribution Scale  
AEs will be categorized according to the likelihood that they are related to the study 
intervention. Specifically, they will be labeled definitely unrelated, definitely related, 
probably related, or possibly related to the study intervention.  
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18.6 AE/SAE Reporting and Follow-up  
AEs will be recorded in the REDCap database within 2 hours of the event using a 
dedicated reporting form. Logging of new information in this database will prompt an 
email alert to the Project Coordinator, Project Manager, and the PIs. The Project 
Manager will respond to the event appropriately, contacting the participant if 
necessary. The PIs will initiate the steps necessary to report the event to the DSMB, 
IRB, and PCORI. Report AEs using the following procedure. 
• Ensure you are connected to NU VPN using the “GlobalProtect” icon on the iPad 

homescreen. 
• Go to  
• Tap/Click the “For Research Team” link. 
• Tap/Click the “AE Reporting” link. 
• Log into REDCap using your NetID and password. 
• Fill in the AE Reporting form. 
• Tap/Click “Exit”. 

19.0 Study Compliance  
Protocol deviations/violations include, but are not limited to, the following: 

• Unblinding  
• Randomization of an ineligible participant 
• Failure to obtain Informed Consent 
• Failure to keep IRB approval up to date 

 
A specific REDCap form is available for reporting unblinding and the process has been 
described previously.  

20.0 Data Collection and Study Forms 
Copies of all pdf versions of all study forms are maintained here.  

20.1 Participant Data 
All data are maintained electronically in secure databases on REDCap. The MoCA and 
audiogram data are recorded on paper and uploaded to REDCap. These paper copies 
are transferred by parcel service from the clinical sites to the coordinating center. The 
forms are stored in locked cabinets at the coordinating center. 

 
20.2 Study Forms 
Two paper forms will be used.  No subject-identifiable information will be on the forms. 
MoCA – Form to conduct and record MoCA, calculate results.  

 Audiogram – Form to record hearing thresholds.  
 

20.3 General Instructions for Completing Forms  
• Use black ink when completing the MoCA and Audiogram forms. 

https://nuwildcat.sharepoint.com/:w:/r/teams/gl_SOC_DharPICORI/_layouts/15/Doc.aspx?sourcedoc=%7B21FB9C02-847B-4583-A1CD-5D00A0A98130%7D&file=Audiogram.docx&action=default&mobileredirect=true
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• Use the iPad camera to upload the forms to REDCap. 
• Ensure the entire form is captured on the iPad screen before taking the photo of 

the form. 
• All MoCA and audiogram data will be crosschecked against the paper copies. 

Additionally, 20% of all forms will be evaluated by a second research assistant to 
assess accuracy of entered data. 

• In case of errors, the data from the form will replace the data entered previously 
in the database. 

• A note will be entered into REDCap documenting the data correction. 
 

20.4 Data Flow 
Most of the data collected will be entered directly into a REDCap database. Data fields 
are mandatory and participants cannot progress through the surveys unless all fields 
are completed. Format checks for specific fields such as dates and email are employed. 
Numeric fields such as the MoCA score and audiogram have range checks in place. 
These measures will reduce errors in data entry. 
 
Photos of the MoCA and Audiogram forms will be uploaded into the REDCap database 
as part of the survey flow. 
 
Data files from the Verifit hearing aid test system and from the Smart Fit hearing aid 
programming software will be uploaded into the REDCap database for a specific 
participant at the end of each test session.  No subject identifiable information is stored 
in the files.  Files are named according to a specified naming convention.  Protocols for 
data uploads are described in the Wrap-up sections for each Session: 

 Session 1 Wrap-up 
 Session 2 Wrap-up 
 Session 3 Wrap-up 

 
All data will be directly entered into a central REDCap database maintained at the 
Coordinating Center.  

20.5 Retention of Study Documentation  
All data and forms will be maintained for a minimum of seven years after the completion 
of the study. 

21.0 Data Management 
Data input into REDCap will be stored on secure servers maintained at Northwestern 
University by the Northwestern University Biomedical Informatics (NUBIC) group. 
Redundant backups, software updates, and interface upgrades will be the responsibility 
of the NUBIC group.  
 
Data extracted for analyses, presentations, and publications will be maintained on 
secure data servers maintained by the School of Communication (SoC) IT group. These 
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data will be automatically backed up by SoC IT and hard drives will be renewed on a 
fixed time-table.  
 
21.1 Quality Control Procedures 

• All study personnel who will administer the MoCA have completed the requisite 
certification. 

• All study personnel who will record data from participants are licensed 
audiologists, therefore qualified to conduct the procedures required for the study. 

• Data entered from paper forms will be verified on an ongoing basis. Twenty 
percent of entered data will undergo a second check by research assistants. 
Data that have to be replaced or corrected will be logged. 

 
21.1.1 Standard Operating Procedures 

The following standard operating procedures will be followed. 
• Audiogram -- https://www.asha.org/policy/GL2005-00014/ 
• Hearing aid evaluation -- https://www.audiologyonline.com/articles/real-ear-

measurement-basic-terminology-1229 
• MoCA –MoCA Administration and Scoring 

 
21.1.2 Data and Form Checks 
The PI or study staff will review all data collection forms on an ongoing basis for data 
completeness and accuracy as well as protocol compliance. Data not recorded 
electronically directly into the database will be automatically crosschecked to ensure 
within expected range. Data recorded on paper or using external instruments will be 
verified by research assistants. The overall integrity of the data will be monitored by the 
biostatistician on the investigative team, Dr. Julia Lee. The following timetable will be 
followed for review of different types of data. 
 
Data type  Frequency of review  Reviewer  
Subject accrual (including 
compliance with protocol 
enrollment criteria)  

Weekly  PIs, Project Manager, Study 
Coordinator, Site Leads   

   
Status of all enrolled 
subjects, as of date of 
reporting   

Monthly  PIs, Project Manager, Study 
Coordinator, Site Leads  

   
Adherence data regarding 
study visits and intervention  

Monthly  Biostatisticians, Project Manager   

   
AEs   Quarterly  PIs, Project Manager, DSMB   
   
SAEs  Per occurrence  PIs, Project Manager, DSMB  
 

https://www.asha.org/policy/GL2005-00014/
https://www.audiologyonline.com/articles/real-ear-measurement-basic-terminology-1229
https://www.audiologyonline.com/articles/real-ear-measurement-basic-terminology-1229
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21.1.3 Site Monitoring 
Representatives from the Coordinating Center will visit the NU, NM, and SER sites once 
each quarter. Representatives from the Coordinating Center will visit the UTMB site two 
times during each year. 
 
The purposes of monitoring visits are to: 

• Ensure the rights and safety of participants 
• Confirm that the study is conducted in accordance with IRB guidelines and 

agreed upon protocol 
• Ensure maintenance of required documents  
• Verify adherence to the protocol 
• Monitor the quality of data collected 
• Ensure accurate reporting and documentation of all AEs and unanticipated 

problems 
 
 
Lead investigators at each site will ensure that the members of the Coordinating Center 
have full access to all study activities during the visit.  
 
Once the site visit is complete, a site monitoring report will be drafted to provide 
feedback regarding any problems or issues that may have been uncovered during the 
visit. The report will, state the problems uncovered during the visit and describe 
recommendations to correct them. A timeline will be agreed upon and included in the 
report to ensure that follow-up of the issues is completed and implemented into the 
study’s procedures. 

22.0 Data and Safety Monitoring Activities 
A Data and Safety Monitoring Board (DSMB) has been formed to oversee all data and 
safety monitoring activities related to the project. The DSMB consists of: 

• Dr. Megan Roberts, Northwestern University, Chair 
• Dr. Donald Nielsen, Don Nielsen Consulting, Executive Secretary 
• Dr. Ruth Bentler, University of Iowa 
• Dr. Kwan-Youn Kim, Northwestern University 

 

22.0.1 Roles and Responsibilities 

• The DSMB Chair is responsible for overseeing the DSMB meetings, assigning 
DSMB members to lead the reviews of specific aspects of the trial (when 
applicable), and consulting with the PIs in developing the DSMB meeting.  

• The DSMB Executive Secretary is responsible for verifying and error checking 
meeting minutes composed by project staff.  

• Project staff will provide the Executive Secretary and the remaining members of 
the DSMB with a draft of the meeting minutes within 5 working days after each 
DSMB meeting. 
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• The PIs have the primary responsibility for all aspects of the clinical trial.   
• The PIs are responsible for providing the DSMB an overview/update of the 

activities related to study and will communicate with the DSMB Chair to ensure 
the DSMB receives the necessary information to effectively monitor the study 
including the current protocol, open session presentation, and requested 
information.   

• The PIs are responsible for ensuring the DSMB recommendations are 
adequately addressed. 

• The study team, with special input from biostatistician Julia Lee, will submit the 
monitoring plan to the DSMB. The monitoring plan outlines the data contents of 
monitoring reports including the DSMB open and closed reports and should 
include the status of the study, interim analyses, adverse events, and summary 
of problems encountered.  

• The study team prepares and distributes the DSMB reports at least one week 
prior to the meeting and addresses DSMB questions related to the information 
presented within the reports. 

 

22.1 Reports 
The study team will create and file progress reports with PCORI every six months for 
the duration of the project. 
 
The study team will prepare and distribute DSMB reports at least one week prior to the 
meeting and addresses DSMB questions related to the information presented within the 
reports. 
 
The study team will create and distribute progress reports to the stakeholder advisory 
group (SAG) at least three days prior to each SAG meeting. 
 

22.2 Study Completion and Close-Out Procedures 
• Coordinating Center staff will verify data entry from all clinical sites to be 

complete. 
• Clinical sites will return study kits including iPads (3), hearing aid fitting kits with 

hearing aids, remote controls, speakers, mirrors, and speaker blocks to the 
Coordinating Center. 

• Coordinating Center will provide complete accounting of hearing aid purchases 
and expenses and transfer funds to the clinical sites as appropriate. 

• The clinical site UTMB will transfer appropriate hearing aid related funds to 
Coordinating Center. 

• PIs will ensure that data and other study records are available for any audits. 
• PIs will notify the IRB of completion of data collection. 
• PIs will complete and file research report with PCORI. 
• Participant notification of the study completion (described below). 
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22.2.1 Participant Notification 

The Principal Investigators and study staff will develop a letter to notify participants that 
the study is completed, ask whether they would like to be informed of the results, and 
thank them for their participation. In addition, a debriefing meeting is planned at each 
clinical site at the completion of data collection. Participants, their family and friends, 
and others interested will be invited to the debriefing sessions. The PIs will present 
preliminary results from the study to the participants and answer questions. 

22.2.2 Site Procedures 

The PIs will provide letters of commendation to each clinical site for their participation in 
the trial. The letter will acknowledge each site’s meeting of recruitment goals and 
adherence to the agreed upon study protocol and quality standards. 

22.2.3 Confidentiality Procedures 

The following safeguards to protect participant confidentiality have been put in place: 

• Data flow procedures – all data will be input into an encrypted and password 
protected REDCap database over secure internet connections. 

• Electronic files – all data will be stored in encrypted and secure data servers 
maintained by NUBIC at Northwestern University. 

• Forms – no identifying information will be recorded on paper forms.  
• Data listings - participant name or any other unique identifiers will not be 

included in any published data listing. 
• Data distribution - data listings that contain participant name, name code, or 

other identifiers easily associated with a specific participant will not be 
distributed. 

• Data disposal – electronic records that contain participant-identifying information 
will be disposed by secure non-recoverable data deletion techniques. 

• Access - participant records will not be accessible to persons outside the study 
without the express written consent of the participant. 

• Storage - study forms and related documents retained both during and after 
study completion should be stored in a locked cabinet in the Coordinating Center. 

22.2.4 Publications 

• Basic results will be reported to ClinicalTrials.gov within 12 months of trial 
completion. 

• A final study report will be filed with PCORI within 6 months of completion of data 
collection. 

• The PIs will outline a list of possible publications and determine the teams to 
work on each publication along with a tentative order of authorship for each 
paper. 

• The list of possible publications, author list, and author order will be reviewed by 
the study team every 3 months and adjusted based on changes in 
responsibilities. 
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• Any disagreements within the study team will be resolved by the PIs. 
• In cases of disagreement between the PIs, the matter will be referred to the 

Stakeholder Advisory Group. 

23.0 MOP Maintenance  
The MOP will be stored in electronic form in a Northwestern University shared file 
system and will be accessible on the home screens of study iPads at each site.  
Portions of the MOP will be available in loose leaf form at each clinical site. These 
portions will be updated as necessary. 
 
All MOP changes will be made by the Coordinating Center. All changes will be 
documented in Appendix D. 
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APPENDIX A - ACRONYM GLOSSARY 
 

Adverse Event (AE) – Any untoward or unfavorable medical occurrence in a clinical 
research study participant, including any abnormal sign (e.g. abnormal physical exam or 
laboratory finding), symptom, or disease, temporally associated with the participants’ 
involvement in the research, whether or not considered related to participation in the 
research. 
 
Coordinating Center (CC) – A group organized to coordinate the planning and 
operational aspects of a multi-center clinical trial.  CCs may also be referred to as Data 
Coordinating Centers (DCCs) or Data Management Centers (DMCs). 

 
Data and Safety Monitoring Board (DSMB) –A group of individuals independent of the 
study investigators that is appointed by the NIA to monitor participant safety, data 
quality and to assess clinical trial progress.  

 
Food and Drug Administration (FDA) – An agency within the U.S. Department of 
Health and Human Services (DHHS) responsible for protecting the public health by 
assuring the safety, efficacy, and security of human and veterinary drugs, biological 
products, medical devices, nation’s food supply, cosmetics, and products that emit 
radiation.  

 
Stakeholder Advisory Group (SAG) – A group of fifteen individuals representing 
patients with hearing loss, audiologists, hearing device industry representatives, and 
advocates for individuals with hearing loss organized to provide guidance to the study 
team on all aspects of the trial.  

 
Health Insurance Portability and Accountability Act (HIPAA) Privacy Rule – The 
first comprehensive Federal protection for the privacy of personal health information. 
The Privacy Rule regulates the way certain health care groups, organizations, or 
businesses, called covered entities under the Rule, handle the individually identifiable 
health information known as protected health information (PHI). 

 
Institutional Review Board (IRB) – An independent body constituted of medical, 
scientific, and nonscientific members whose responsibility it is to ensure the protection 
of the rights, safety, and well-being of human subjects involved in a trial by, among 
other things, reviewing, approving, and providing continuing review of trials, protocols 
and amendments, and of the methods and material to be used to obtaining and 
documenting informed consent of the trial participant. 

 
Manual of Procedures (MOP) – A “cook book” that translates the protocol into a set of 
operational procedures to guide study conduct. A MOP is developed to facilitate 
consistency in protocol implementation and data collection across study participants 
and clinical sites.  

 
Principal Investigator (PI) - The individual with primary responsibility for achieving the 
technical success of the project, while also complying with the financial and 
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administrative policies and regulations associated with the award. Although Principal 
Investigators may have administrative staff to assist them with the management of 
project funds, the ultimate responsibility for the management of the sponsored research 
award rests with the Principal Investigator. 
 
Serious Adverse Event (SAE) – Any adverse event that: 

• Results in death  
• Is life threatening, or places the participant at immediate risk of death from the 

event as it occurred  
• Requires or prolongs hospitalization  
• Causes persistent or significant disability or incapacity  
• Results in congenital anomalies or birth defects  
• Is another condition which investigators judge to represent significant hazards 
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Appendix A - Sample Screen Log 

 
Study:  [Study Name] 
Site: [Site Name] 
Investigator:  [Investigator Name] 

 
 

Participant ID 
Date of 
Birth 

Gender 
 

Screening 
Date 

Screening 
Status 

(use codes 
below) 

Consent 
Obtained 

 

Enrolled 
(if no, indicate 
reason from 

codes below) 

Date 
Enrolled 

 /  / 
mm/dd/yyyy 

 M 
 F 

/  / 
mm/dd/yyyy   Yes 

 No 
 Yes 
 No 

/  / 
mm/dd/yyyy 

 /  / 
mm/dd/yyyy 

 M 
 F 

/  / 
mm/dd/yyyy   Yes 

 No 
 Yes 
 No 

/  / 
mm/dd/yyyy 

 /  / 
mm/dd/yyyy 

 M 
 F 

/  / 
mm/dd/yyyy   Yes 

 No 
 Yes 
 No 

/  / 
mm/dd/yyyy 

 /  / 
mm/dd/yyyy 

 M 
 F 

/  / 
mm/dd/yyyy   Yes 

 No 
 Yes 
 No 

/  / 
mm/dd/yyyy 

 /  / 
mm/dd/yyyy 

 M 
 F 

/  / 
mm/dd/yyyy   Yes 

 No 
 Yes 
 No 

/  / 
mm/dd/yyyy 

 
Sample Screen Status Codes: 1-Eligible If not eligible, Reason: 1-Inclusion # (specify) 
 2-Eligible, declined participation  2-Exclusion# (specify) 
 3-Not Eligible  3-Other (specify) 
 4-Eligible, lost to follow-up   
 5-Other, specify in space provided   
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Appendix B - Schedule of Events 
 
 

SB – Screening (S) or Baseline (B) 
FU – Follow-up 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Visit Description Pre-
Screening 

SB **FU **FU 

Study Visits/ Study 
days (or weeks) 

 

On 
Contact 

Session 1 
Day 0 

2 
W6 

3 
W24 

Demographics X    
HHIE-S X    
Screening 
Consent  S   

MoCA  S   
Audiogram  S  X 
PHAP  B X  
HHIE  B X  
PROMIS  B X  
Case History  B   
HA Fit  X   

Real Ear  AB only CD/ 
EF  

Coupler Measures   X X 

Adverse Events  X X X 

Study completion    X X 
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Appendix C: Files to be Generated and Uploaded in each Session  
 
  S1 AB  S1 CD  S1 EF  S2 AB  S2 CD  S2 EF  S3 AB  S3 CD  S3 EF  
.xml 1  x      x  x  x  x  x  x  
.xml2        x  x  x  x  x  x  
.pdf  x  x  x  x  x  x  x  x  x  
.png 1        x  x  x  x  x  x  
.png2        x  x  x  x  x  x  
   
Session 1  
AB Group:    

Verifit:   on-ear  and test box data (.xml)  
Smart Fit:   Clinician Report (.pdf)  

CD/EF Groups:  
Smart Fit:   Clinician Report (.pdf)  

  
Session 2  
AB Group:  

Verifit:  on-ear data #1 (.xml #1)  
Verifit: on ear data #2 (.xml #2)  
Smart Fit:   Clinician Report (.pdf)  
Smart Fit:  Data logging screenshots x2 (.png, 2 files)  

CD/EF Groups:  
• Verifit:  on-ear data #1 (.xml #1)   
• Verifit:  on-ear and test box data (.xml #2)  
• Smart Fit:   Clinician Report (.pdf)  
• Smart Fit:  Data logging screenshots x2 (.png, 2 files)  

 
Session 3  
All Groups:  

Verifit:  on-ear data #1 (.xml #1)  
Verifit: on-ear data #2 (.xml #2)  
Smart Fit:   Clinician Report (.pdf)  
Smart Fit:  Data logging screenshots x2 (.png, 2 files)  
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Appendix D - MOP Modification Log 

 
MOP MODIFICATION LOG 

 
Section # Ver 

# 
Date 

Modified Page # Text Location Brief Modification Summary 
 1 1/25/21 2 Title Corrected links to individual sessions 

13.4,13.5, 13.6 1 1/25/21 various  Added links to advance to different points within sessions 
13.5, 13.6 1 1/25/21 various  Clarification on how to find participant files in NOAH 

13.4 1 1/25/21 32,36,41,45  Added instructions about rebooting hearing aids 
13.4,13.5,13.6 1 1/25/21 Various  Added instructions about clearing data from previous participant before starting session with 

a new participant 
Appendix E 1 1/25/21 84  PHAST-R 
Appendix F 1 1/25/21 86  P-CHAT Fitting App description 

13.4.7d, 13.4.8 1 2/5/21 38,48  Added step to Reset Data Logging 
13.4.7d, 13.4.8 1 2/5/21 38,48,52  Moved step of saving Clinician Report from Wrap-up to when aids are connected 
13.4.7d, 13.4.8 1 2/5/21 34,44  Added what to do if firmware in aids needs to be updated 

13.5.1 
13.6.1 

1 2/8/21 53,55 
61,63 

 Moved questionnaires to after HA measures 

13.5.1 
13.6.1 

1 2/8/21 53 
60 

 Changed doing as-is coupler measures to doing on-ear measures 

13.5.1 
13.6.1 

1 2/8/21 55 
62 

 Changed doing post-maintenance coupler measures to doing on-ear measures 

13.5.1 1 2/8/21 55  Changed doing on-ear measures for CD/EF groups to doing coupler measures 
13.5.1 
13.6.1 

1 2/8/21 56 
62,63 

 Download and save data logging and Clinician Report prior to disconnecting aids 

13.5.1 
13.6.1 

1 2/8/21 57 
64 

 Upload HA data files prior to Wrap-up 

13.5.3 
13.6.1 

1 2/8/21 59 
66 

 Added question to HA Problems Inventory about aids not staying in ears 

13.4.6 1 2/8/21 30  Modified Post-Randomization statement to participants 
13.5.1, 13.6.1 2 2/15/21 52, 61  Changed stimulus levels for as-is on-ear speech mapping to one level at 65 dBSPL 
13.5.1, 13.6.1 2 2/15/21 53, 62  Added LDL instructions for after-maintenance on-ear MPO test. 
Appendix F 2 2/15/21 92  Chun Chan added participant ID validation error documentation  

8.0, 8.3, 13.4.1 2 3/1/21 15, 16,25  Changed MoCA cut off score to 23 
8.0, 8.3, 13.4.1 2 3/4/21 15, 16,25  Changed MoCA cut off score back to 26 (pending IRB approval) 
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Section # Ver 
# 

Date 
Modified Page # Text Location Brief Modification Summary 

13.4.7 2 03/04/21 31  Added step re: Audiogram Mismatch message 
13.4.7 2 03/16/21 32  Changed DFS Ultra II in-ear calibration is needed for all AB participants 

8.0, 8.3, 13.4.1 2 3/16/21 15, 16,25  Changed MoCA cut off score to 23 
8.3, 13.4.2 3 6/21/21 16,26 list Added symmetry of hearing loss criteria at 500 and 1kHz 
Appendix G 3 6/21/21 104  Added description of computers used for programming aids 

13.3.2, 13.4.7,13.4.8 3 6/21/21 20, 30, 40, 42  Refers to Appendix G in description computer and programming aids 
13.4.7a,13.4.8 3 6/21/21 31,41  Added info about matching domes to receiver type 

13.4.8 3.1 10/20/21 42  Changed steps for checking hearing aid settings for CD and EF groups In session 1; added 
Appendix H with Clinician Reports 

13.4.7b, 13.4.8. 3.1 10/20/21 31,41  Added steps to take if Error message is displayed when starting Noah; added Appendix I for 
further instructions 

13.4.10, 13.5.5,13.6.6 3.1 10/20/21 46,55,63  Added laptop backup procedures, added Appendix J 
13.4.9,13.5.4,13.6.5 3.1 10/21/21 44,54,63  Added links to Clover Tips document 

4.1.1, 4.1.3, 14.4 3.1 10/21/21 7, 9, 66  Amended personnel 
15.0 3.1 10/21/21 68  Amended refund information 

13.4.5 3.1 2/11/22 28  Changed steps for randomization through REDCap 
15.1 3.1 2/11/22 70  Changed steps for accessing additional forms 

13.4.9 3.1 2/15/22 44  Added campus address to check information 
13.4.8 3.1 2/15/22   Edited log in instructions for fitting app 

15.0, 13.4.8, 13.4.7 3.1 2/15/22   Clarified exit instructions 
4.0, 4.1 3.1 8/23/22   Updated personnel lists and site contact information 
13.5.4 3.2 9/27/22   Refunding payments modifications for credit cards, debit cards and checks 

Appendix K 3.2 9/27/2022   Added Appendix K for NU-ARL instructions 
13.5.1, 13.6.1 3.2 10/4/2022   Added step for Saving data from aids to Noah database in S2 and S3; added instruction to 

skip step if second datalogging screen not available. 
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Appendix E – PHAST-R 
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Appendix F – P-CHAT Fitting App 
 

P-Chat Hearing Aid Fitting App 
 
Introduction 
The P-Chat Hearing Aid Fitting app is a self-guided iPad application for selecting and 
fitting a hearing aid. 
 
Purpose 
The application was purpose built for a research project sponsored by the Patient-
Centered Outcomes Research Institute. The application assists a hearing aid seeker in 
choosing the following physical features of the hearing aid (fitting stage): 

Receiver wire length 
Dome size 
Color 

 
The application also assists the hearing aid seeker to determine a rank order of 
preference for four pre-programmed acoustic settings. The pre-programmed acoustic 
settings are determined based on standard hearing loss configurations of gently sloping, 
mild to moderate, symmetrical hearing loss. 
 
Development Stack 
Front end: Vue.js JavaScript framework 
Back end: Apache webserver provided by School of Communication, Information 
Technology Department (SOC-IT) at Northwestern University. 
 

 
 
 
 
 
 
 
 
 
 

 

 

 
 
 
Flow Chart 
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Blue: fitting stage 
Orange: programming stage 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Initialization 

Welcome Page 

Participant starts with medium dome and medium/2 receiver for right 
ear. 

 Receiver length check. If too long, replace with shorter receiver. 
 

Dome Size Selection. If too tight, select smaller dome. If too loose, 
select larger dome. 

 
Participant picks up the appropriate left side aid. 

 
Participant confirms selections 

 
Participant listens to 20 second speech samples for all four hearing 
programs   

 Participant rates all four hearing programs using speech, music and 
everyday sounds sound samples. Ratings are from 1 to 10 (10 = 
excellent, 1 = poor). 

 Participant selects desired hearing aid color 
 

Preferred program is selected based on ratings 
Data is pushed to RedCap 
Audiologist selects the appropriate hearing aid based on the Rx 
report. 
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To start, an audiologist first logs in to app with Northwestern netID and password. Note 
that access will be denied if the audiologist's netID has not been added to RedCap. For 
test runs, enter participant "0" to avoid saving data to RedCap. 
 

The following error messages will be presented if the entered participant ID fails 
validation. 

1. Participant was flagged as ineligible to participate. 

 

 

2. Incorrect or invalid participant ID. Participant IDs must be whole number integers. 
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3. Participant is in the wrong group. Only CD and EF participants use the iPad self-
fitting app. 
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4. Participant has already participated. This error message shows up if a previous 
participant’s ID is entered into the iPad self-fitting app. 

 
 
 
 
At the welcome screen, the iPad is handed over to the participant. 
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Box Layout 
Hearing aids must be arranged in the box following this layout. 
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Workflow 
Participant is instructed to fit the hearing aid from the "circle" section in their right ear. 
 
Receiver	length		
Participant will be asked to select which photo matches their hearing aid receiver length.  
Photo A is the desired outcome. Photo B means that receiver length is too long. If 
participant selects photo B, we direct them to select a hearing aid with a shorter receiver 
length from the "square" section. 

 
 
Dome	fit	
Participant is then asked if the dome feels [a] just right, [b] too loose may fall out or [c] 
uncomfortably tight. If [b], we direct the participant to switch to the aids in the "heart" 
section (if they previously indicated preference for the short/1 receiver) or the "cross" 
section (if they previously indicate preference for the medium/2 receiver). If [c], we direct 
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the participant to switch to the aids in the "triangle" section (if they previously indicated 
preference for the short/1 receiver) or the "start" section (if they previously indicate 
preference for the medium/2 receiver) 
 
Left	aid	
The participant is then directed to select the matching hearing aid for the left ear. 
 
Confirm	
Participant confirms choices or taps the back button to change dome or receiver length 
sizes 
Past this point, the participant can no longer make changes to the hearing aid fit.  
 
This point marks the end of the “fitting stage” and the duration of time spent from the 
welcome screen to this point is saved as “fittingTime” in the output json file. 
 

 
 
Hearing	aid	program	settings	
The participant is instructed to take the remote control from the appropriate section and 
then watch an instructional video guiding them through the use of the remote control. 
They are asked to select program 1 and then listen to a 20 second file that includes 4 
sentences, 3 environmental sounds, and a segment of music.  Participants must listen 
to the full 20 second sound clip for all programs. 
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Next, the participant indicates their preference on a scale of 1 to 10 for each of the 
programs and must click through and listen to all three sound file types (speech, music 
and everyday sounds) before a rating can be submitted. In this section, a different set of 
sentences and music selections are used.  
 
The amount of time spent listening to each music sample is recorded. This is repeated 
for all four hearing aid programs. 
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The web app will determine which programs is the preferred program based on the 
following tables 
 

Preferred 
Program 

Slot 1 Slot 2 Slot 3  Slot 4 

1 1 2 3 4 
2 2 3 4 1 
3 3 2 1 4 
4 4 3 2 1 

 
Tie type Options ranked the same Preferred 
2 way tie 1 vs 2 2 
 1 vs 3 3 
 1 vs 4 1 
 2 vs 3 2 
 2 vs 4 2 
 3 vs 4 3 
3 way tie 1 vs 2 vs 3 2 
 1 vs 3 vs 4 3 
 2 vs 3 vs 4 3 
 1 vs 2 vs 4 2 
4 way tie 1 vs 2 vs 3 vs 4 2 
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Close	out	
The participant will watch an instructional video on how to change programs on their 
hearing aid using the hearing aid buttons 
 
Hearing aid color preference is indicated on the next screen (gray, beige or brown). 
Samples are provided in the "rainbow" section. 
 

 
 
The amount of time between the “Dome selection” and the “Thank You” screen is stored 
under “programmingTime” in the output json file. 
 
The final "Hearing Aid Rx" screen is presented to the audiologist who will select and 
program the hearing aids for the participant to purchase. 
 
The "touched" section tells the audiologist which sections the participant picked up 
during the course of fitting the hearing aid. 
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Output json file 
At the exit page (Hearing Aid Rx), data are saved to RedCap. Below is an example of 
the json output with comments. 
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Acoustic Stimuli 
 

{ 
    "audiologist": "Jane Doe", 
    "site": "Evanston", 
    "receiverLength": "medium2", 
    "domeSize": "mediumDome", 
    "color": "beige", 
    "rating1": 10, 
    "rating2": 10, 
    "rating3": 7, 
    "rating4": 8, 
    "program": 2, 
    "ranking": [ 
        2, 
        3, 
        4, 
        1 
    ], 
    "record_id": 1, #Redcap record_id 
    "listenTimeProgram1": { 
        "speech2.mp3": 4.06, #duration spent listening to speech sound sample 
        "music.mp3": 25.123, #duration spent listening to music sound sample 
        "environmental.mp3": 12.957 #duration spent listening to environmental sound sample 
    }, 
    "listenTimeProgram2": { 
        "speech2.mp3": 12.347, 
        "music.mp3": 22.922, 
        "environmental.mp3": 18.345 
    }, 
    "listenTimeProgram3": { 
        "speech2.mp3": 31.201, 
        "music.mp3": 41.102, 
        "environmental.mp3": 39.192 
    }, 
    "listenTimeProgram4": { 
        "speech2.mp3": 52.631, 
        "music.mp3": 19.989, 
        "environmental.mp3": 34.131 
    }, 
    "fittingTime": 342.111, #duration spent on the fitting pages (Welcome page to Dome Size page) 
    "programmingTime": 1283.512, #duration spent on the programing pages (Dome Size page to Thank 
you page) 
    "touched": [ 
        "images/circle.png" 
    ], 
    "timestamp": "2020-11-11 11:11:00" 
} 
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The acoustic stimuli in the app include standardized samples of speech, music and 
environmental sounds. The sound files were used in a previous study evaluating 
hearing aid service delivery models (Humes et al., 2017).   
 
The speech files are sentences recorded using male and female talkers. The sentences 
are low-context and in a name-verb-number-adjective-noun format (Hagerman 
sentences).  Each sentence is approximately 2 seconds in length.   
 
Environmental sounds in the 20 second sound file include a bird chirping, a car engine 
starting, and a phone ringing.   The additional sounds in the rating section include 
footsteps, flowing creek, siren, baby cry, dog bark and cough.  Each individual sound is 
approximately 1-2 seconds in length.  
 
Music samples are from a commercial recording of classical music performed by a 
symphony orchestra.   
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Appendix G – Computers and Procedures for Programming Hearing Aids 
 
During May 2021, new equipment was provided to each site to use for programming the 
hearing aids to maintain consistency and minimize problems with hearing aid settings. 
Please do not update or change the software or software settings (especially the 
Preferences in SmartFit) unless instructed otherwise. This new equipment included: 

Lenovo ThinkPad laptop with Noah v. 4.13 and SmartFit v. 1.9 
NoahLink wireless programmer 
Wireless mouse 

 
Only hearing aids with firmware version .44 or .45 can be programmed with the laptop.   
Follow these steps to use the laptop: 

• Press fingerprint button to turn on laptop.  
PIN = pcori 
Close window that pops up about connecting to a network.  DO NOT connect to a network. 
Open Noah 4; Click OK in Noah 4 pop-up (ABC and Noah Server are selected). 
Wait a bit. If you get an error message, select Cancel and restart Noah. 
Noah has 3 patient files, one for each group, that can be used to copy settings into hearing aids 
if needed in the future.  
When a participate comes in for Session 1, create a new patient file: 
First Name = Group (AB, CD, or EF) 
Last Name = ID # 
Do NOT enter gender or Date of Birth 
Enter AC thresholds only for AB, using participant’s thresholds 

 
Click on ReSound Smart Fit module to open; Smart Fit window will open behind the Noah 
window, so it may be easier not to have them full-screen. 
Continue with connecting aids.  If an error message appears about needing to update the 
SOFTWARE, this indicates that the firmware in the aids is v.1.18.  You will not be able to use the 
laptop for these hearing aids and will need to use Smart Fit on the computer previously used 
(see below for details).   
If a message appears asking to update the firmware from version .44 to v.45, select YES (this will 
take about 5 minutes). 
After aids are connected, change View>Stimulus>Speech Weighted Noise. 
For AB group, complete protocol for fitting aids. 
For CD and EF groups, re-order programs according to order selected in Fitting App. 
For all groups, save pdf of Clinician Report to desktop (create a Clinician Reports folder if one is 
not there).   
SAVE fitting to hearing aids and database. 
Copy Clinician Report pdf file to USB stick labeled Smart Fit and transfer to PC to upload to 
REDCap. 
When a participant comes in for Session 2 or 3, and their hearing aids were NOT previously 
programmed on the laptop, create a new patient file (see above).   Then connect and use the 
session in the hearing aids and save.  However, if the firmware in the aids is v.1.18, then you 
will need to use the old PC and Noah database. 
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When connecting aids to SmartFit, if a message appears that the SOFTWARE (not the 
firmware)  needs to be updated, this indicates that the firmware in the hearing aids is 
version 1.18.  The laptop CANNOT be used with this version of firmware, therefore the 
PC that was previously used for programming the hearing aids must be used: 

o Open the patient file from their previous sessions in the Noah database on the PC 
o Open SmartFit and connect the hearing aids 
o Use the session in the hearing aids 
o If prompted to update the Firmware in the hearing aids, do NOT update the firmware beyond 

version 1.18 (until after participant exits study). 
o The SmartFit Preferences shown below must be selected prior to saving or checking settings. 

Select Edit>Preferences:   
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Enter the name of your site here. 
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Appendix H – Clinician Reports for CD and EF Settings  
 

CD Settings 
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EF Settings 
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If the settings in the hearing aids do not match the Clinician Report settings shown here, 
follow these steps: 
•  Verify these settings: 

• NAL-NL2 

• Experienced non-linear user 

• Gain level = 100% 
• Select under Fitting in top black tool bar: 

• Binaural Correction = on (red X = on) 

• Enable Safe Fitting = off 

• Verify that DFS Ultra II = Moderate in all 4 programs for both aids 

• If not turned on, complete DFS Calibration in an open 2cc coupler 
for each aid with receivers positioned just inside coupler 

 
 
• Check that shape of the gray “tornadoes” are similar for both aids 

and repeat calibration if they are not 
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Appendix I – Noah Error Messages 
The following error message, or a similar one, sometimes is displayed when Noah is 
started.   

 
Select “Cancel” and restart Noah.  If unable to start Noah, follow these steps: 
 
 
The Noah 50138 Error 
The 50138 error is most often resolved by a stop/start of the Noah Client and Noah Server services. 
Open Control Panel and type “services” in the search window, then select View local services… 

 
 
The items are in alphabetical order.  Look for NoahClient and NoahServer 
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When you highlight the Noah service you should see an option to start/stop the service at the top of the 
screen or by right clicking on the service.  Stop the NoahClient , and then the NoahServer service.   
Then start the NoahServer, and then NoahClient service. 
 
 
The 323 error It is recommended to make sure Windows is updated. You can connect to the internet and 
run any Windows updates the computer tells you to run.  Get info on updates from: 
https://support.microsoft.com/en-us/windows/update-windows-3c5ae7fc-9fb6-9af1-
1984-b5e0412c556a 
 
  

https://support.microsoft.com/en-us/windows/update-windows-3c5ae7fc-9fb6-9af1-1984-b5e0412c556a
https://support.microsoft.com/en-us/windows/update-windows-3c5ae7fc-9fb6-9af1-1984-b5e0412c556a
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Appendix J- Laptop Back-up Procedure:   Complete Monthly 
 

1. Put USB stick labeled “Back-up” into laptop 
a. Leave “System Volume Information” folder alone 

2. Open Noah and Go to File>Export Patients 
3. This Window will pop up.  Make selections as shown: 
 

 

 
 

4. Select “Export” 
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5. This Window will pop up.  Fill in the information as shown: 
 

 
 

6. Enter “Save” 
7. The “Save As” Window will pop up and select D drive with ENFAIN (D) 
8. Name the file “Noah Backup [Month Year]” E.g., “Noah Backup October 2021” 
9. “Save” 
10. Message “Patients exported successfully”:  OK 

 
11. To backup Clinician Reports:  Open File Explorer 
12. Find Folder with Clinician Reports and drag to ENFAIN (D) to copy them there 
13. Open ENFAIN (D) and confirm that “Clinician Reports” folder and Noah Backup file are there.   
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Appendix K– NU-ARL Protocols 
 
Starting 9/28/2022, some of the Session 2 and Session 3 appointments will be 
completed in the Auditory Research Lab (ARL) in room 1-181 of the Frances Searle 
Building (FSB).  These sessions will be run by second year AuD students who have 
been trained on the P-CHAT protocols.  They will be supervised by the Project 
Manager, Mary Meskan. 
 
These supplies for the session will be locked in cabinet 5 in the ARL: 

• Parking placards and parking garage tokens 
• iPad 
• Clover device 
• Gift cards 
• USB thumb drives labeled S2S3 CR and S2S3 Verifit 

Otoscope, specula, and PHAST-R kit will be stored in drawer next to table. 
Cleaning tools, wax filters, and extra domes will be stored in drawer next to desk top 
PC.  
Completed audiograms will be filed in the file drawer next to the PC. 
 
Participants will be provided with directions to park in the surface lot adjacent to the 
FSB.  They are then asked to call the P-CHAT number to indicate that they have 
arrived.  If there are no spaces available in the surface lot, they will be instructed to park 
in the North Parking garage.  The RA covering the phone will then message the AuD 
student that the participant has arrived.  The student will take a yellow parking placard 
out to the participant to put in the car windshield.  If parked in the garage, they will be 
provided with a paid parking token.  The student will escort the participant to the ARL.   
 
Follow current Covid protocols.  Paper masks and hand sanitizer are provided. 
 
Follow protocols for Session 2 (section 13.5 in MOP) or for Session 3 (section 13.6). 
 
At “Download and save Datalogging data”, if this is the first time the participant has 
been seen in NU-ARL, they will not have a Noah file stored on the laptop.  Follow these 
steps to create a file and to download settings from hearing aids: 
• Open Noah 

• If Error message is displayed, cancel and restart Noah 

• If Error message continues to display after repeated restarts, refer to Appendix I 

• Open ‘New Patient.’ 
Last Name = participant ID#, First Name = AB or CD or EF (depending on group) 
Do not enter any other information. 
Select OK 
Do not enter the audiogram because it is stored in the hearing aids. 

• Select ReSound SmartFit fitting module.   
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• Power on hearing aids by removing from a charger or by pressing the buttons for 5 
seconds.  Listen for the 10 dings to indicate they are turning on.  

• Select “Connect” hearing aids.   

• Once discovered, check the left and right boxes and verify left and right by using 
“beep”.   Switch left and right if needed. 

• “Continue” 
• Message:  “Data Mismatch”;  Select “Read instrument Data” because you want the 

Fitting Data and Audiogram in the instrument to be loaded for this session. 

• “Continue”  
Continue following steps in MOP for saving Datalogging  
 
 
 


